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Chapter 1: Introducing Workshare 
Compare
This chapter introduces Workshare Compare, providing an overview of how it works as 
well as a summary of the key features and benefits. It includes the following sections:

 What is Workshare Compare?, page 9, introduces Workshare Compare.

 Workshare Compare Functionality, page 9, describes the different areas of 
functionality of Compare.

 Accessing Compare Functionality, page 12, describes how to access Compare
functionality after install.

 Licensing, page 13, describes how to license Compare after install.
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What is Workshare Compare? 

Workshare Compare reimagines multi-party review and collaboration and ensures the safe 
and accurate exchange of information, enabling the collaborative evolution of high value 
business documents. 

Workshare Compare is a desktop application that automates managing changes to 
business documents.

Key features of Workshare Compare include:

 Comparison of Word, PowerPoint, Excel and PDF files, including image-based 
PDF files

 Comparison of selected pieces of content, such as a single paragraph or clause

 Ability to accept/reject changes in a comparison and then create new documents

 Advanced comparison features including one-to-many comparisons (Word and 
PDF files), version comparisons, and access from within Office and Document 
Management Systems

 Access to comparison functionality from within Outlook as well as right-click access 
from within individual emails

 ECM/DMS and OCR integration with desktop comparison features

Note: Workshare Compare can be installed without Microsoft Office integration. In this 
case, the comparison functionality is only available from the Workshare comparison
applications.

Workshare Compare Functionality

Workshare Compare provides sophisticated functionality that is convenient and 
accessible, enabling users to move smoothly between tasks and work rapidly to manage 
changes. Workshare Compare assists you throughout the complete document lifecycle –
from document assembly, review, verification and security. Workshare Compare has also 
made key functionality of the DMS available, for example, enabling the comparison of 
DMS versions.



Introducing Workshare Compare

10

What can Compare do?

Workshare Compare reinvents multi-party review by helping users understand, 
communicate and implement changes more quickly and accurately. Compare shows 
precise changes between versions of Word, PDF, PowerPoint and Excel files including 
DMS files and versions. The DeltaView redline sets the standard for an easy-to-read, 
accurate view of changes between document versions. Compare’s advanced comparison 
engine performs comparisons accurately and seamlessly enabling users to quickly 
compare even the most difficult and complex documents, presentations and spreadsheets.

See the changes

With Microsoft Word and PDF files, users can perform one-to-one and one-to many 
comparisons and see accurate DeltaView redlines in individual tabs. Compare compares
both regular text-based PDF files and image-based PDF files that originate from scanned 
documents, automatically applying OCR (Optical Character Recognition) processing to 
translate the images of typewritten text into editable text. Compare provides access to files 
and version information stored in a DMS/CRM or SharePoint and users can browse for 
files to compare as well as save comparisons into the DMS/CRM or SharePoint.

Users can launch Compare from the environment that suits them:

 Launch a comparison of an attachment directly from an email message

 Launch a comparison from within Word, Excel or PowerPoint

 Launch a comparison from within a DMS/CRM or SharePoint

Selective Compare enables the user to copy snippets of text from anywhere and run a 
comparison in Workshare. This is much faster and more focused than comparing an entire 
document.

Understand the changes

Compare provides an intuitive interface that enables users to navigate easily between 
changes. Category View divides changes according to type, for example, numbering 
changes, punctuation changes or matching changes, enabling users to quickly focus on 
the changes that are important to them.

Implement the changes

When comparing Word and PDF files, Compare includes the ability to accept and reject 
changes (individually or as a group)  and create a new Word document that includes all 
the changes.
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DMS/CRM integration

Workshare Compare can integrate with your DMS or CRM as well as SharePoint to 
provide comparison and other functionality.

Note: To integrate with a DMS/CRM or SharePoint, Workshare Compare must be 
installed with the relevant integration selected and additional details may need to be 
configured in the Workshare Configuration Manager. Refer to your system administrator 
for further information.

The specific functionality available with each DMS/CRM integration is detailed in the table 
below:

Note: The comparison functionality relates to all file types – Word, PDF, Excel and 
PowerPoint – unless specified.

Functionality iManage Net
Documents

OpenText Worldox SharePoint

From Workshare 
comparison 
application, browse 
to DMS

From Workshare 
comparison 
application, save to 
DMS

Right-click from 
within DMS, launch 
Workshare 
comparison

1 2 3

1 The right-click option is available in iManage FileSite/DeskSite clients. If you’re using 
the iManage Work 10 web client, you can access Workshare comparison for Word 
and PDF files from the kebab menu but you will need the Workshare IManage 
Integration Server installed. See Installing WIIS in the knowledge base for more 
information.

2 The Workshare options are available via Send to application functionality in 
NetDocuments for Word, PDF and Excel files.

3 The Workshare options are available for Word, PDF and Excel files. In Worldox, 
Workshare comparison is also available using the Compare Files button in the toolbar.

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
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Accessing Workshare Compare

Workshare Compare can integrate with Microsoft Word, Excel, PowerPoint and Outlook so 
that comparison is available from within these Office applications. Additionally, Workshare 
Compare, Workshare Compare for Excel and Workshare Compare for PowerPoint are 
available as standalone applications. 

After you have installed Compare, toolbar options are added to a Litera tab in the ribbon in 
your Microsoft Office applications - Word, Excel and PowerPoint. The addition of Compare 
does not affect the standard functionality of Word, Excel or PowerPoint. You can operate 
these applications as usual and access the Compare functionality as required.

Workshare Compare functionality can also be accessed in the following ways:

 Right-click closed Word, Excel, PowerPoint or PDF files and select Compare with 
Workshare.

 Right-click attachments in Outlook and select Compare Attachments.

 Click Compare or Selective Compare in the Litera ribbon in Outlook.

The Workshare Compare standalone application can also be accessed 
from the Start menu or by double-clicking the Workshare Compare icon 
on the desktop.

The Workshare Compare for PowerPoint standalone application can 
also be accessed from the Start menu or by double-clicking the 
Workshare Compare for PowerPoint icon on the desktop.

The Workshare Compare for Excel standalone application can also be 
accessed from the Start menu or by double-clicking the Workshare 
Compare for Excel icon on the desktop.

Note: Workshare Compare can be installed without Microsoft Office integration. In this 
case, the Workshare toolbar options are not available. The Workshare comparison 
functionality is only available from the Workshare standalone applications.
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Workshare toolbar options

In Office applications, the Workshare toolbar options are included in the Litera tab as 
follows:

Whether these options are included in the ribbon is configurable from the General > User 
Interface category in the Workshare Configuration Manager. Refer to Workshare 
Configuration Options for further information.

The Workshare toolbar options are as follows:

Group Item Description

Compare Compare Enables you to compare a Word, Excel or PowerPoint file with a 
previous version of the same file or with another file. Refer to 
Overview - Comparing Documents and Introducing Compare for 
PowerPoint for further information.

Selective 
Compare

Enables you to compare a snippet of text with another snippet 
of text. Refer to Comparing Selected Content for further 
information.

Options Options Enables you to configure system parameters in the Workshare 
Configuration Manager. Refer to Introducing the Workshare 
Configuration Manager for further information.

Info Help Provides access to version, copyright and license information 
about Workshare Compare as well as online help.

Enabling Workshare Compare functionality

To ensure Workshare Compare functionality is fully enabled, you should work with saved 
documents. If you are working in Microsoft Office on an unsaved document and you select 
Compare, the following message is displayed:
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Licensing

After installation, you are prompted to log in to your Workshare account in order to retrieve 
your license entitlements. This prompt displays the first time you access Workshare 
functionality, for example, by clicking any Workshare option in the ribbon. You will see the 
following:

Note: You can also open the Workshare Configuration Manager, select the My Products
tab and click Sign in.
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Enter your Workshare credentials (email address and password) for Workshare and click 
Sign in. Your license entitlements are retrieved and you have access to all Workshare 
functionality. Your license entitlements are shown in the My Products tab of the 
Workshare Configuration Manager.

Users who do not yet have a Workshare account can click Create an account in the login 
dialog. Workshare checks their email address and will automatically register them against 
your corporate Workshare account and update their license entitlement.
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Chapter 2: Comparing Documents
This chapter describes Workshare Compare, a standalone application that enables you to 
compare two or more Microsoft Word or PDF documents. It includes the following 
sections:

 Overview – Comparing Documents, page 17, introduces the Workshare Compare 
application.

 Performing Comparisons, page 18, describes how to compare a document 
against an earlier version of the document or against a different document using 
Workshare Compare.

 Comparing Selected Content, page 24, describes how to compare a snippet of 
content with another snippet of content.

 Ensuring Successful Comparisons, page 25, describes how Workshare 
Compare performs comparisons using auto retry mode and failsafe mode.

 Workshare Compare Main Window, page 28, describes the Workshare Compare 
environment and provides an overview of the functionality available.

 Working with redlines, page 44, describes the tools available to you when working 
with the compared (redline) document after a comparison.
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Overview - Comparing Documents 

Note: This chapter describes how to compare Word documents and PDF files. The 
comparison of PowerPoint presentations is described in Chapter 3 and the comparison of 
Excel spreadsheets is described in Chapter 4.

The Workshare Compare application compares documents – the original document and 
the modified document – and produces a comparison (redline document), enabling you to 
instantly see any differences between them. In one view, you can see the source 
documents and the resulting DeltaView redline. You can compare an original document 
against several different modified documents and see the redline for each comparison in a 
different tab. You can run multiple comparisons and each time the redline is shown in a 
new tab. You can select documents locally, from your DMS or CRM or from your network.

You can compare any of the following file formats:

DOC DOCX PDF RTF TXT

Workshare Compare’s powerful engine accurately and reliably displays document changes 
in a redline document with the differences clearly marked. For example, deleted text is red 
and struck through and added text is blue and double underlined. All content is compared 
including images, tables and embedded Microsoft Excel tables. You can review the 
redline, navigating between the changes and accepting or rejecting the changes to create 
a new and revised document. To make the review easier, you can customize how the 
changes are highlighted within the document.
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PDF comparison

Workshare Compare can compare both regular text-based PDF files and image-based 
PDF files that originate from scanned documents. Regular PDF files are compared by 
converting them to RTF before performing a comparison. With image-based PDF files, 
Workshare Compare will first apply OCR (Optical Character Recognition) processing to 
translate the images of typewritten text into editable text and then produce an RTF file. 

PDF files that originate from scanned documents may include:

 PDF files generated from files that have been scanned: OCR (Optical Character 
Recognition) has already been used to translate images of typewritten text into 
editable text. Workshare Compare supports the comparison of such PDF files.

 PDF files that have been created directly from the scanning: Where OCR has not 
been used and PDF files contain pure images of text. Workshare Compare applies 
OCR to the PDF files before performing comparisons. 

Notes:
If you compare scanned PDF files without applying OCR, it may result in a blank redline.

Workshare Compare can perform OCR on the following languages: English, Danish, 
Dutch, Finnish, French, German, Italian, Norwegian, Polish, Portuguese, Spanish, 
Swedish and Russian.

Performing Comparisons

You can compare your original document against any previous version of the document or 
against another document entirely. For example, there may be ten versions of a document 
in your DMS. You can open version 3 and compare it against version 5. You can also 
compare a document against multiple versions. For example, you can open version 3 and 
compare it against version 5, version 7 and version 10.

Note: You cannot compare secure PDFs, meaning PDF files with security settings 
configured.

You can launch Workshare Compare and perform comparisons from within Microsoft 
Word, from your desktop, from right-click options or from an email and each of these 
scenarios is described in the following sections.

Note: Comparison of selected pieces of text, such as a single paragraph or clause, is 
described in Comparing Selected Content. 
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Launching Workshare Compare from Microsoft Word

In this scenario, you first open your document in Microsoft Word.

To compare documents:

Click Compare in the Litera tab. The Compare Documents dialog is displayed with the 
open document in the Modified Document field. Select the file to compare it against as 
described in Launching Workshare Compare from your desktop.

Launching Workshare Compare using right-click options

You can launch Workshare Compare by right-clicking documents in File Explorer or in your 
DMS (iManage/OpenText/Worldox).

 Right-click the original document and select Compare with Workshare. The 
Compare Documents dialog is displayed with the selected document in the Original 
Document field. Select the files to compare it against as described in Launching 
Workshare Compare from your desktop.

 Select the original and modified documents, right-click and select Compare with 
Workshare. The Compare Documents dialog is displayed with the selected 
documents in the Original Document and Modified Document fields. Continue as 
described in Launching Workshare Compare from your desktop.

You cannot launch Workshare Compare from SharePoint using right-click options.

You can launch Workshare Compare from the Work 10 browser interface using the kebab 
(context) menu if you have WIIS (Workshare iManage Integration Server) installed. See 
this knowledge base article - Installing Workshare iManage Integration Server.

http://workshare.force.com/knowledgebase/articles/Text_Article/Installing-Workshare-iManage-Integration-Server
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Launching Workshare Compare from email

You can launch Workshare Compare from the dropdown context menu of an attachment to 
an email or using the Compare button in the Litera tab.

 Select one (or two attachments), click the dropdown and click Compare 
Attachments.

The Compare Documents dialog is displayed with the attachment in the Modified
Document field. Continue as described in Launching Workshare Compare from 
your desktop.

 With an email selected in your inbox, click Compare in the Litera tab. If the email 
doesn’t include attachments, the Compare button is disabled. If the email includes 
one or two Word or PDF attachments, the Compare Documents dialog is displayed 
with the attachments selected. If the email contains more than two attachments, the 
following dialog is displayed:
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Select the attachments you want to compare and click Continue. The Compare 
Documents dialog is displayed with the attachments selected. Continue as 
described in Launching Workshare Compare from your desktop.

Note: If you select attachments that can’t be compared for example, a DOCX and 
an XLSX, the Continue button will be disabled.

Launching Workshare Compare from your desktop

In this scenario, you launch Workshare Compare as a standalone application from your 
desktop or the Start menu. You then select the documents you want to compare. 

To compare documents: 

1. Double-click the Workshare Compare shortcut on your desktop or select
Workshare Compare from the Start menu. The Compare Documents dialog is 
displayed:
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2. Select the original document you want to compare:

 Drag the file over the Original Document field, or

 Click to the right of the Original Document field, navigate to the 
document location in your local file system, SharePoint or DMS/CRM and click 
Open.

The selected document is displayed in the Original Document field.

Tip: You can also enter text directly into the text box. Workshare Compare will 
predict locations as you type. This is possible for locations accessible from the 
local machine but not for locations in a DMS.

3. Select the document you want to compare with the original document:

 Drag the file over the Modified Document field, or

 Click to the right of the Modified Document field, navigate to the 
document location in your local file system, SharePoint or DMS/CRM and click
Open. 

The selected document is displayed in the Modified Document field.

Tip! If you want to compare a recently used file, click the dropdown in the 
Original Document and Modified Document fields and select the documents 
you want to compare. These lists contain the last 10 documents you have used.

When working with iManage, and the selected document has versions, the recent 
files list can also include these versions. In this way, you can easily compare 
different versions of your iManage documents. 

Tip! To swap the original and modified documents, click . This button is only 
available if you are comparing two documents rather than comparing multiple 
documents against an original document.

4. If you want to compare the original document against another document, click . 
An additional Modified Document field is added.

5. Select the document you want to compare with the original document:

 Drag the file over the second Modified Document field, or

 Click to the right of the second Modified Document field, navigate to the 
document location in your local file system, SharePoint or DMS/CRM and click
Open. 

6. Repeat step 5 to add further documents as required.
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7. From the Rendering Set dropdown list, select the rendering set you want to use. 
Rendering sets contain a set of parameters that define how changes are displayed 
in the redline (compared) document. You can select from the standard rendering 
sets provided with Workshare Compare or you can create and customize your own 
rendering sets (described in Introducing Rendering Sets).

Note: Clicking to the right of the Rendering Set field displays the Rendering 
Sets Manager where you can create, modify and delete rendering sets. For a full 
description refer to Introducing Rendering Sets.

8. From the Comparison Mode dropdown list, select the type of comparison you 
want to perform from the following:

 Standard: Workshare Compare performs a regular comparison.

 Fast: When comparing a DOC or DOCX file against another DOC or DOCX file,
Workshare Compare performs a binary comparison which is faster than a 
standard comparison.

Note: The Fast option is only available if the Enable fast comparison parameter
(Comparison > Administration category) in the Workshare Configuration 
Manager is selected.

 Text Only: Workshare Compare performs a text-only comparison, comparing 
only the text in a document and not the formatting or styles.

 Compare without OCR: Workshare Compare compares PDF files without first 
performing OCR. With image-based PDF files, Workshare Compare will first 
apply OCR (Optical Character Recognition) processing to translate the images 
of typewritten text into editable text in order to compare. If you do NOT want 
Workshare Compare to perform OCR, select this option.

9. Click OK. The comparison process is launched and a progress dialog is displayed.

Tip: Progress is also indicated by the shading in the Task Bar icon for Workshare 

Compare 
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When the comparison is complete, the redline is displayed in the Workshare Compare 
window. If the original document has been compared against multiple documents, each 
redline is displayed in a different tab. For a full description of the Workshare Compare 
interface, refer to Workshare Compare Main Window.

Note: When comparing a PDF file, the display may vary according to the type of PDF -
the software used to create the PDF file. For example, Adobe, Amyuni, CutePDF, 
novaPDF, and so on.

Comparing Selected Content

You can use Selective Compare to run a comparison on snippets of content pasted from 
emails, chats or files. This is much faster and more focused than comparing an entire 
document. Content can include text, tables, code and images and results are displayed in 
the familiar Compare environment.

To compare selected content:

1. From the Litera tab, click Selective Compare.

2. Drag the content you want to compare into the Original area or click in the area to
paste your content there. The content can include text, images, tables, code. 

3. In the Modified area, drag or paste the content you want to compare with the 
original content.

Tip! To swap the original and modified content, click .

4. Click Compare. The comparison is displayed in the Workshare Compare window.
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Ensuring Successful Comparisons

If Workshare Compare cannot complete the comparison, it will do one of two things:

 Invoke auto retry mode, if it is enabled.

 Invoke failsafe mode, if auto retry mode is not enabled or if Workshare Compare 
cannot complete the comparison in auto retry mode.

Auto retry mode

If Workshare Compare is unable to complete the comparison, and auto retry mode is 
enabled, then Workshare Compare attempts to perform the comparison using reduced 
settings. For example, Workshare Compare may attempt to compare the documents 
without comparing field codes or without comparing footnotes. Workshare Compare 
repeatedly attempts to perform the comparison disabling settings one at a time until the 
comparison is successful.

Note: Auto retry mode is enabled in the rendering set – the Allow Auto Retry parameter 
in the Comparison Options category of the Rendering Sets Manager.

Once the comparison is successful, a message is displayed informing you that the 
comparison has been performed using reduced settings. Click OK and scroll to the 
Redline Options Summary, which is displayed at the beginning or end of the redline 
according to the settings in the selected rendering set (in the 

Use classic table 
comparison

If selected, tables are compared as they were in releases 
prior to Workshare Compare 10.1 Revision 1.

The Workshare Compare 10.1 Revision 1 release introduced 
an updated method of table comparison that creates more 
readable results in the vast majority of cases.

Redline Options category of the Rendering Sets Manager). Even if the rendering set does 
NOT have the Include Redline Options Summary parameter selected, when Workshare 
Compare performs an auto retry the Redline Options Summary is always displayed after 
the comparison.

The Redline Options Summary indicates which settings Workshare Compare disabled in 
order to perform the comparison. For example:

Redline Options Summary

Option: Status:

Redline Statistics at End of Document ON

Include Redline Comparison Summary OFF

Show Line Numbering OFF
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Redline Options Summary

Show Change Numbers OFF

Show Change Bars on Left ON

Show Hidden Text OFF

Detect List Numbering Changes ON

Compare Headers/Footers ON

Compare Footnotes SET OFF

Display Compare Footers OFF

Ignore Embedded Objects/Images OFF

Compare at Character Level OFF

Compare Numbers at Character Level OFF

Show Moved Deletions OFF

Show Changes to Spaces OFF

Show Paragraph Changes OFF

Ignore Case Changes OFF

Ignore Textboxes SET ON

Ignore Field Codes OFF

Ignore Tables OFF

Note: The comparison may take longer than usual because Workshare Compare is 
attempting to compare using different settings.

The status indications are as follows:

ON This setting is selected and was applied during the comparison.

OFF This setting is not selected and was not applied during the comparison.

SET ON This setting was not selected but was enabled by Workshare Compare 
and applied during the comparison.

SET OFF This setting was selected but was disabled by Workshare Compare and 
not applied during the comparison.

If Workshare Compare cannot complete the comparison even using reduced settings, 
failsafe mode is invoked.
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Failsafe mode

If Workshare Compare is unable to complete the comparison and auto retry mode is 
disabled, or if Workshare Compare cannot complete even a reduced comparison in auto 
retry mode, then failsafe mode is invoked. Failsafe mode means that Workshare Compare 
performs a text-only comparison, comparing only the text in a document and not the 
formatting or styles.

You can manually invoke failsafe mode so that a text-only comparison is performed. You 
may want to do this if, after a full comparison, your redline was not fully shown in 
Workshare Compare for any reason. Additionally, you may want to do this if you are more 
interested to see text changes rather than formatting and style changes.

To manually invoke failsafe mode:

Before running the comparison, select Text Only as the Comparison Mode in the 
Compare Documents dialog.
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Workshare Compare Main Window

The Workshare Compare main window enables you to view redlines - the results of a 
comparison between an original document and a modified document. You can view (in one 
work area) both source documents, the redline and a summary of the changes between 
the two source documents.

When you select to run multiple comparisons, each resulting redline is displayed in an 
individual tab.
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Moving and placing windows

The Source Documents window and the Change Summary window can easily be moved 
to different positions in the Workshare Compare main window according to individual 
preference.

Left-click the title bar of the Source Documents window or Change Summary window and 
then drag the window to your preferred position. The selected window will float over the 
workspace.

To dock a window:

Left-click the title bar of a floating window and keep the mouse button pressed. Positioning 
arrows appear at the top, bottom, left and right of the Workshare Compare main window, 
as well as in the center.

Move the mouse pointer over the required positioning arrow and release the mouse 
button. The window is docked in the selected location. For example, dragging the Change 
Summary window over the left positioning arrow will dock the Change Summary window 
down the left side of the Workshare Compare main window.

To hide a window:

Click in the top right corner of the Source Documents window or the Change Summary 
window or use the options in the Layout group on the Home tab.
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To auto-hide a window:

Click in the top right corner of the Source Documents window or the Change Summary 
window. The selected window is hidden with just a tab remaining.

For example, if the Change Summary window is displayed on the left side of the 
Workshare Compare main window:

1. Click , the Change Summary window is hidden with just a tab displayed on the 
left side.

2. Hover over this tab, the Change Summary window is displayed again and you can 
work in it as required.

3. Click elsewhere, for example in the redline, the Change Summary window is 
automatically hidden again.

To turn off auto-hide, click .
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Quick access toolbar

The quick access toolbar provides one-click access to popular functionality. By default, the 
New Comparison, Open Comparison, Save and Save As buttons are included in the 
quick access toolbar. By clicking the arrow to the right of the quick access toolbar, you can 
customize it as follows:

Select/deselect the New Comparison, Open
Comparison, Save or Save As options to display/hide 
these options in the quick access toolbar.

Select More Commands to add additional options to the 
quick access toolbar.

Select Show Below the Ribbon to display the quick 
access toolbar below the ribbon.

Select Minimize the Ribbon to hide the details of the 
ribbon until you click the Home, Review or View tabs.

Note: To change the commands that appear in the quick access toolbar, right-click in the 
ribbon and select Customize the Ribbon. Refer to Customize the Workshare ribbon.

File menu

Clicking File displays a menu with the following options:

Option Description

New Comparison Opens the Compare Documents dialog enabling you to 
perform a new comparison. Refer to Launching 
Workshare Compare from your desktop.

Open Comparison Enables you to open a saved comparison. Comparisons 
are saved as Workshare DeltaFiles (.WDF). Refer to 
Opening saved Workshare DeltaFiles.

Save Enables you to save the current comparison. Refer to 
Saving redlines.

Save As Includes the following sub-options:

Comparison 
document

Enables you to save the redline as a WDF, DOC, 
DOCX, TXT, RTF, HTM or PDF file. Refer to Saving 
redlines.
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Option Description

Word document with 
Track Changes

Enables you to save the redline as a DOCX document 
with the changes shown as track changes. Refer to 
Saving redline as track change document.

Email Includes the following sub-options:

Attach as PDF Converts the redline to PDF and opens a new email 
window with the PDF attached. Refer to Sending by 
email.

Attach as PDF (only 
pages with changes)

Converts the changed pages in the redline to PDF and 
opens a new email window with the PDF attached. 
Refer to Sending by email.

Attach as Word 
document with Track 
Changes

Converts the redline to a Word document with the 
changes shown as track changes and opens a new 
email window with the document attached. Refer to
Sending by email as track change document

More email 
options….

Enables you to select which documents from the 
comparison to email and in what format. Refer to 
Sending by email.

Print Enables you to print the redline and includes the 
following sub-options: Refer to Printing redlines.

Comparison only Enables you to print the redline. 

Comparison + 
Modified

Enables you to print the redline and the modified source 
document.

Comparison + 
Modified + Original

Enables you to print the redline, the modified source 
document and the original source document.

Print Preview Enables you to preview the print output and includes the 
following sub-options:

Comparison only Enables you to preview the redline. 

Comparison + 
Modified

Enables you to preview the redline and the modified 
source document.

Comparison + 
Modified + Original

Enables you to preview the redline, the modified source 
document and the original source document.

Help Includes the following sub-options:

Help Provides access to online help.

About Displays version and copyright information about 
Workshare Compare.

Keyboard shortcuts Displays a list of keyboard shortcuts available in 
Workshare Compare.
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Option Description

License Displays information about your Workshare Compare 
license in the My Products page of the Workshare 
Configuration Manager.

Workshare Config 
Manager

Opens the Workshare Configuration Manager where, if 
you have permission, you can configure system 
parameters. Refer to Introducing the Workshare 
Configuration Manager for further information.

Exit Workshare 
Compare

Closes the Workshare Compare application. You are 
prompted to save any open redlines.

Home tab

The Home ribbon provides access to key functionality in Workshare Compare.

The options are described in the following table.

Group Option Description

New New 
Comparison

Opens the Compare Documents dialog enabling you 
to perform a new comparison. Refer to Launching 
Workshare Compare from your desktop.

Comparison 
document

Save As Includes the following sub-options:

Comparison 
document

Enables you to save the redline as a WDF, DOC, 
DOCX, TXT, RTF, HTM or PDF file. Refer to Saving 
redlines.

Word 
document 
with Track 
Changes

Enables you to save the redline as a DOCX document 
with the changes shown as track changes. Refer to 
Saving redline as track change document.

Email Includes the following sub-options:

Attach as 
PDF

Converts the redline to PDF and opens a new email 
window with the PDF attached. Refer to Sending by 
email.
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Group Option Description

Attach as 
PDF (only 
pages with 
changes)

Converts the changed pages in the redline to PDF and 
opens a new email window with the PDF attached. 
Refer to Sending by email.

Attach as 
Word 
document 
with Track 
Changes

Converts the redline to a Word document with the 
changes shown as track changes and opens a new 
email window with the document attached. Refer to
Sending by email as track change document.

More email 
options…

Enables you to select which documents from the 
comparison to email and in what format. Refer to 
Sending by email.

Print Enables you to print the redline and includes the 
following sub-options: Refer to Printing redlines.

Comparison 
only

Enables you to print the redline. 

Comparison 
+ Modified

Enables you to print the redline and the modified 
source document.

Comparison 
+ Modified + 
Original

Enables you to print the redline, the modified source 
document and the original source document.

Close All Closes all open comparisons.

Convert PDF Enables you to convert the redline to PDF. Refer to 
Converting redline to PDF.

Word Includes the following sub-options:

Open in 
Word

Opens the redline in Microsoft Word where you can 
edit it. Refer to Showing changes as text.

Open in 
Word with 
Track 
Changes

Opens the redline in Microsoft Word with the changes 
converted to track changes so you can implement 
changes using track changes functionality. Refer to 
Showing changes as track changes.

Change 
Navigation

Change 
Summary

Displays/hides the Change Summary window.

Search Displays the Search tab in the Change Summary 
window enabling you to search for specified text or 
keywords in the redline and source documents. 

Previous Navigates to the previous change and highlights the 
entire change in the redline. Refer to Navigating 
between changes.



Comparing Documents

35

Group Option Description

Next Navigates to the next change and highlights the entire 
change in the redline. Refer to Navigating between 
changes.

First Navigates to the first change and highlights the entire 
change in the redline. Refer to Navigating between 
changes.

Last Navigates to the last change and highlights the entire 
change in the redline. Refer to Navigating between 
changes.

Specific Enables you to navigate to a specific change number. 
The entire change is highlighted in the redline. Refer 
to Navigating to a specific change number.

Comparison 
Themes

Select Enables you to select a different rendering set from 
the dropdown list and Workshare Compare 
automatically re-runs the comparison applying the 
selected rendering set. Refer to Introducing Rendering 
Sets.

Edit Opens the Rendering Sets Manager where you can 
apply different rendering sets to a comparison and, if 
you have permission, you can add, edit and delete 
rendering sets. Refer to Introducing Rendering Sets.

Layout Select Enables you to select what is displayed in the 
Workshare Compare window.

Comparison 
only

Hides the Source Documents window and displays the 
redline only.

Comparison 
+ Original

Displays the redline as well as the original document 
in the Source Documents window.

Comparison 
+ Modified

Displays the redline as well as the modified document 
in the Source Documents window.

Comparison 
+ Original + 
Modified

Displays the redline as well as both source 
documents.
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More tab

The More ribbon provides access to other useful functionality.

The options are described in the following table.

Group Option Description

Original/
Modified

Swap Swaps the original and modified documents. Refer to 
Swapping the source documents.

Mode Comparison 
Mode

Enables you to select a comparison mode from the 
dropdown list and Workshare Compare automatically re-
runs the comparison in the selected mode – Fast, 
Standard, Text Only or Image Based PDF.

Info Help Includes the following sub-options:

Help Provides access to online help.

About Displays version and copyright information about 
Workshare Compare.

Keyboard 
Shortcuts

Displays a list of keyboard shortcuts available in 
Workshare Compare.

License Displays information about your Workshare Compare 
license in the My Products page of the Workshare 
Configuration Manager.
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Customize the Workshare ribbon

To change the commands that appear in the Workshare Compare ribbon and quick access 
toolbar, right-click in the ribbon and select Customize the Ribbon.

To customize the Compare environment to suit your needs, you can select which 
commands to include in the Home and More tabs or add new tabs.

The redline

The DeltaView redline shows the results of the comparison between the original document 
and the modified document. Changes are marked according to the rendering set applied to 
the comparison. For example, deleted text could be red and struck through and added text 
could be blue and underlined.

You can navigate between the changes in the redline and accept/reject the changes to 
create a new and revised document. You can also save the redline locally, or to your DMS 
or to Workshare online. All of these options are described in Working with Redlines.
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Redline tabs

When the original document has been compared against multiple modified documents, or 
when you have run multiple comparisons, each resulting redline is displayed in a different 
tab. Select the tab header to display the comparison in the Workshare Compare window. 
You can also display the tabs simultaneously side by side by clicking and dragging the tab 
header across the Workshare Compare window.

Redline right-click menu

Right-clicking text or changes in the redline displays a popup menu, providing rapid access 
to some of the more commonly used tools.

Option Description

Copy Copies selected text to the clipboard.

Select All Selects all the content of the redline.

Find Displays the Search tab in the Change Summary window enabling you to 
search for specified text or keywords in the redline and source 
documents.

Find Next When you have specified text or a keyword in the Search tab, navigates 
to the next occurrence of the specified search text or keyword.

Edit redline Opens the redline in Microsoft Word where you can edit it. Refer to 
Showing changes as text.

Convert to 
Track 
Changes

Opens the redline in Microsoft Word with the changes converted to track 
changes so you can implement changes using track changes 
functionality. Refer to Showing changes as track changes.

Zoom Enables you to change the display of the redline from 20% to 200% of its 
original size. 
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Option Description

Link to 
Move

When text has been moved to another position, navigates and highlights 
the text in its new or previous position in the redline. 

 When right-clicking text in its new position, clicking Link to Move
highlights the text in its previous position.

 When right-clicking text in its original position, clicking Link to Move
highlights the text in its new position.

You must right-click a move-type change for this option to be available.

Link to 
Change

Jumps to the redline Summary (at the end of the redline) highlighting the 
selected change. You must right-click a change for this option to be 
available.

Note: The Include Redline Comparison Summary parameter 
(Redline Options category of the Rendering Sets Manager) must be 
selected in the applied rendering set.

Redline comparison summary

At the beginning or end of the redline, you can see a summary of the comparison and a list 
of the changes found. 

In order for the redline to include this summary, the Include Redline Comparison 
Summary parameter in the Redline Options category of the Rendering Sets Manager
must be selected in the applied rendering set.
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Change Summary window

The Change Summary window provides a list of changes found between the source 
documents. Selecting a change highlights the change in the redline and displays the 
position of the change in both the source documents. From the Change Summary window, 
you accept and reject changes. Refer to Reviewing changes.

You can hide/display the Change Summary window by clicking Change Summary in the 
Home tab.

Tip! The Change Summary window is by default positioned down the left side of the 
Workshare Compare environment. It can be moved as required. Refer to Moving and 
placing windows.

The Change Summary window includes two tabs – Changes and Search – and the 
Changes tab has three views. These are described in the following sections.

Changes tab Category View
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The Changes tab, Category View displays all the changes between the original document 
and the modified document according to the type of change. The changes can be grouped 
into any of the following categories:

 Numbering Changes: Any changes to numbering lists identified in a document.

 Whitespace Changes: Changes that only involve whitespace – ie deletion/insertion 
of spaces or tabs, or a space changing to a tab or 3 spaces changing to tabs.

 Capitalization Changes: Any changes to the capitalization of a word.

 Punctuation Changes: Any changes to a punctuation mark.

 Spelling Corrections: Changes where a single word replacement includes the 
deletion of a word that is not a dictionary word and the insertion of a dictionary word 
in its place. The replacement word must also be a spell check suggestion for the 
replaced word – for instance replacing ‘recieve’ with ‘receive’.

 Word Variations: Changes which involve changing the form a word ie replacing 
‘confirms’ with ‘confirmed’ – the two words (original and replacement) must come 
from the same stem word and just have different endings.

 Matching Changes: Changes that are repeated and identical.

 Suggested Changes: Changes that a reviewer could have neglected to make. For 
example, there are 400 instances of “ACME INC” in the original document but the 
reviewer has only changed 399 of these to “Workshare Inc”. The Suggested
Changes category will indicate that there is 1 change that might have been missed.

 Style Changes: Changes made to styles in a document.

 Font Changes: Changes made to font type, font style, font colour, underline style, 
underline color and font effects.

 Footnote Changes: Any changes in the footnotes of a document.

 Endnote Changes: Any changes in the endnotes of a document.

 Header Changes: Any changes in the headers of a document.

 Footer Changes: Any changes in the footers of a document.

 Placeholder Changes: Blocks of placeholder text that are found to be matching 
between the original and modified documents. While these are not changes 
between the two documents as such, they highlight areas where the editing of the 
document may be incomplete. Typical blocks of placeholder text might be ‘[Client 
Name]’, ‘[Company Address]’ etc.

 Boilerplate Changes: Changes that occur inside blocks of boilerplate text. These 
changes merit special attention as in general boilerplate text should not be 
modified. Note that the change is only marked as a boilerplate change if it is found 
inside an occurrence of one of the boilerplate text items in the original document.

 Comment Changes: Changes that have been made to comments.

 Uncategorized Changes: Changes that do not fall into any of the above groups.
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Changes tab List View

The Changes tab, List View displays all 
the changes between the original 
document and the modified document in 
the order that they occur. The following 
information is shown for each change:

#: The number of the change in the 
document. A change may have two 
numbers when it includes two actions. 
For example, a deletion and an addition.

Page, Line: The page number and the 
line number in the original document 
where the change occurs.

Accept: Whether you accept the 
change or not.

Change Text: Details of the change.

Changes tab Status View

The Changes tab, Status View
displays all the changes between the 
original document and the modified 
document according to their review 
status – Accepted, Not Accepted or 
Flagged. When you have selected the 
checkbox to the left of a change, it 
appears under Accepted.
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Search tab

The Search tab enables you to search 
for changes in the redline that include a 
specific keyword or text. Refer to 
Searching for changes.

Source Documents window

The Source Documents window is where you can view the documents that have been 
compared. You can select (from the Layout group in the Home tab) to display the original 
document, the modified document or both documents in the Source Documents window.
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You can scroll through both documents. Selecting a point in one source document 
automatically scrolls the other source document as well as the redline to the same point. 
The source documents are read-only and cannot be modified in any way. The name of the 
source document is shown above the document.

Tip! The Source Documents window is by default positioned across the top of the
Workshare Compare environment. It can be moved as required. Refer to Moving and 
placing windows.

Right-clicking text in the original document or the modified document displays a popup 
menu, providing rapid access to some of the more commonly used tools.

Option Description

Copy Copies selected text to the clipboard.

Select All Selects all the content of the original or modified document.

Find Displays the Search tab in the Change Summary window enabling you 
to search for specified text or keywords in the redline and source 
documents.

Find Next When you have specified text or a keyword in the Search tab, navigates 
to the next occurrence of the specified search text or keyword.

Zoom Enables you to change the display of the original or modified document 
from 20% to 200% of its original size. 

Working with Redlines

This section describes the tools available to you when working with the DeltaView redline 
after a comparison.

Navigating changes

After performing a comparison, you can review the redline (the result of the comparison) 
and look through the changes between the original and modified documents. You can 
move between changes in the redline by jumping from change to change or searching for 
a specific change using change numbers or keywords. You can also accept or reject the 
changes and create a new document based on your decisions – refer to Reviewing 
changes.
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Navigating between changes

Selecting a change in the Change Summary window highlights the change in the redline 
and displays the position of the change in both of the source documents.

 Click Previous in the Home tab to move to the previous change and highlight the 
entire change in the redline. Click First to move to the first change in the redline.

 Click Next in the Home tab to move to the next change and highlight the entire 
change in the redline. Click Last to move to the last change in the redline.

Navigating to a specific change number

Changes are allocated numbers, which are displayed next to the change in the Change 
Summary window. A change may have two numbers when it includes two actions, for 
example, a deletion and an addition. You can move to a specific change number in the 
redline.

To navigate to a specific change number:

1. Click Specific in the Home tab. The following dialog is displayed:

2. In the Change Number field, enter the number of the change you want to display 
in the redline.

3. Click Go To. The entire change is highlighted in the redline.

4. Repeat steps 2 and 3 to navigate to further changes as required.

5. Click Close to close the dialog.

Tip! To maximize this feature, apply a rendering set with the Show Change Numbering
parameter selected in the Redline Rendering category, Change Numbering section. This 
shows all the change numbers against each change in the redline, for example, 

.
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Searching for changes

You can search for changes in the redline that include a specified keyword or text. 
Workshare Compare can search only the changes for the specified text or it can search 
the text of the original or modified documents.

To search for a change:

1. In the Change Summary window, select the Search tab or click Search in the 
Home tab.

2. In the text box at the top of the Search tab, enter the search criteria – the word or 
words for which you want to search.

3. If the case is not important, select the Ignore Case checkbox.

4. Select where you want to search from the dropdown list. The options are as 
follows:

 Search changed text only: Searches through all text in the redline that has 
been changed.

 Search text near a change: Searches through all text in the redline that has 
been changed and also text that is within 100 characters of a change.

 Search Original Document text: Searches through all text in the original 
document.

 Search Modified Document text: Searches through all text in the modified 
document.

 Search all Redline text: Searches through all text in the redline.

5. Click Search. A list of changes that include the specified word or words is 
displayed in the lower text area.

Selecting a change in the search results highlights the change in the redline and displays 
the position of the change in both the source documents.
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Reviewing changes

You can accept and reject changes from within Workshare Compare and create a new 
Word document that includes all your changes. Changes can be accepted/rejected 
individually or as a group. Using the Category View of the Changes tab, you can choose 
to accept or reject an entire category. For example, the Matching Changes category 
includes changes that are repeated and identical and you can accept or reject them all at 
one time. Switching to Status View provides an easy way to quickly see what changes 
haven’t yet been reviewed.

Selecting a checkbox next to a change indicates you want to accept it. Not selecting a 
checkbox indicates you want to reject that change.

To accept/reject changes:

1. Review the changes that you care about and mark them in any of the following 
ways:

 In the Change Summary window, select the checkbox to the left of an individual 
change to accept it.

 In Category View, select the checkbox to the left of a category to accept all 
changes in that category.

Tip! You can select all changes in a category by selecting the category checkbox 
and then deselect one or two changes within that category as required.

 Right-click an individual change or a category and select Flag. This is a way to 
highlight the change – perhaps for future consideration or to check sources.

 Right-click an individual change or a category and select Mark as Read. This is 
a way to indicate that you have reviewed the change but do not want to give it a 
status.

Note: To reset a change marked as read, select Mark as Unread from the right-
click menu.

You reject a change by leaving it unselected. 

2. When you have completed your review, click Apply Accepted Changes at the 
bottom of the Change Summary window. A new Word document is opened with the 
selected changes accepted and the unselected changes rejected. You can save 
this document as your new master document.

Note: Changes to comments (grouped in the Comments category) will not be 
accepted.
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The comparison is not altered in any way so you can return to the comparison in 
Workshare Compare and change your mind about whether to accept changes or not. 
Every time you click Apply Accepted Changes, a new Word document is opened with the 
current accept/reject statuses applied.

You can also save the comparison as WDF file and this will save all your selections along 
with the source documents and redline document. You can open this WDF at a later time 
and continue working or send it a colleague for further review.

Editing redlines

A redline remains an accurate comparison of two documents and cannot be directly edited 
in Workshare Compare. However, you can open the redline in Microsoft Word and edit the 
document as required. There are two ways of opening the redline in Word – one where the 
changes appear as text and another where the changes appear as track changes.

Showing changes as text 

Using this method, changes appear as normal text with just the formatting to identify them. 
For example, if the rendering set used in the comparison showed inserted text as red with 
a double underline, then the text will appear as red with a double underline in Word.

To open the redline in Word:

1. In the Home tab, click Word and then Open in Word or right-click in the redline 
and select Edit redline. The redline is opened in Microsoft Word with the default 
name redline.docx. All the changes are displayed as ordinary text but with 
formatting marks indicating whether they are additions, deletions and so on.

2. Edit the document as required.

3. Save the document. By default, the document is saved in a temporary folder.

Showing changes as track changes

Using this method, the changes are converted to track changes and you can implement 
the changes using Microsoft Word’s track changes functionality. 

Note: The converting to track changes functionality is only enabled, if the Enable 
Convert to Track Change functionality parameter (Comparison > User Interface
category) in the Workshare Configuration Manager is selected.

To convert to track changes:

1. In the Home tab, click Word and then Open in Word with Track Changes. The 
redline is opened in Microsoft Word with all the changes displayed as track 
changes.
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2. Review the track changes and implement them as required.

3. Save the document. By default, the document is saved in a temporary folder.

Changing the comparison

You can re-run a comparison swapping the source documents, changing the comparison 
mode, applying a different rendering set or changing specific comparison options.

Swapping the source documents

You can re-run a comparison exchanging the original document for the modified document 
and the modified document for the original document. For example, if you selected 
Document A as the original document and Document B as the modified document, 
Workshare Compare compares Document A to Document B and presents the changes 
made to Document A. You can then swap the original and modified documents so that 
Document B is now the original document and Document A is the modified document. 
Workshare Compare automatically re-runs the comparison, comparing Document B to 
Document A, and presents the changes made to Document B.

To swap the source documents:

Click Swap in the More tab to swap the source documents. Workshare Compare 
automatically runs a new comparison, using the modified document as the original 
document and the original document as the modified document. The new redline is 
displayed in the same tab replacing the first comparison.

Changing the comparison mode

You can re-run a comparison using a different comparison mode (or type) if required.

To re-run a comparison using a different mode:

In the More tab, click Comparison Mode and then select the required mode from the 
following:

 Fast: Workshare Compare performs a fast comparison. When comparing a .DOC 
file against another .DOC file, Workshare Compare performs a binary comparison
which is faster than a standard comparison because it is comparison at the binary 
level. When comparing a .DOCX file against another .DOCX file, Workshare 
Compare performs a faster comparison by converting the documents to DOC 
followed by comparison at the binary level.

Note: The Fast option is only available if the Enable fast comparison parameter
(Comparison > Administration category) in the Workshare Configuration 
Manager is selected.

 Standard: Workshare Compare performs a regular comparison.
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 Text Only: Workshare Compare performs a text-only comparison, comparing only 
the text in a document and not the formatting or styles.

 Image Based PDF: Workshare Compare will re-run the comparison and force OCR 
processing on scanned/image content. You may want to try this if Workshare 
Compare has performed a Standard or Fast comparison and some scanned/image 
content has not been converted to text.

Note: This type of ‘forced’ OCR may be useful when scanned pages are difficult to 
detect, for example, when they have lots of annotations on top of the scans like 
Bates numbering, etc. or when the text is actually vector output (from a CAD 
product for example) and there are no actual characters with fonts in the PDF.

Workshare Compare re-runs the comparison using the selected mode and displays the 
resulting redline in the Workshare Compare main window.

Applying a different rendering set

You can re-run a comparison using a different rendering set.

To re-run a comparison with a different rendering set:

1. In the Home tab, click Select in the Comparison Themes group. A list of the 
currently defined rendering sets is displayed.

2. Select the rendering set to apply.

Workshare Compare re-runs the comparison using the selected rendering set and displays 
the resulting redline in the Workshare Compare main window.
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Changing the comparison options

You can re-run a comparison changing specific options within the rendering set.

To re-run a comparison with different options:

1. In the Home tab, click Edit in the Comparison Themes group. The Rendering Sets 
Manager is displayed.

2. Edit the rendering set parameters as required. For example, select the Ignore 
Tables checkbox. Rendering set parameters are described in Rendering Set 
Parameters.

3. Do one of the following:

 Click Apply. Workshare Compare re-runs the comparison using the selected 
parameters and displays the resulting redline in the Workshare Compare main 
window. Click OK to close the Rendering Sets Manager. Any changes you made 
to the rendering set parameters are lost.
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 Click OK. The save dialog is displayed. Enter the name of an existing rendering 
set to overwrite a rendering set or enter a new name to create a new rendering 
set. Do not use the following characters when naming rendering sets: <, >, :, \, “, 
/, \\ or |. Click Yes. Workshare Compare re-runs the comparison using the 
revised options and saves the revised options as the specified rendering set. 
Click No. Workshare Compare re-runs the comparison using the revised options
and saves the revised options as a temporary rendering set called “Custom 
rendering set”. 

Note: The “Custom rendering set” will be selected in the Rendering Set dropdown list the 
next time the Rendering Sets Manager is opened. However, once you navigate away 
from the “Custom rendering set” and a different rendering set is selected and the 
Rendering Sets Manager is closed, the “Custom rendering set” is lost.

Distributing redlines

After you have compared your documents, Workshare Compare provides many options for 
saving or circulating the redline. Workshare’s DeltaView redline can be distributed in many 
formats, such as PDF or TXT or DOCX. Only if it is distributed as a WDF will your ‘Accept’ 
and ‘Flag’ selections, as well as the source documents, be included. WDF files can only be 
opened in Workshare Compare. The redline can also be distributed as a Word document 
with the changes shown as track changes. The following sections describe how you can 
distribute your redlines:

 Save locally or to your DMS, refer to Saving redlines

 Email, refer to Sending by email

 Print, refer to Printing redlines

 Convert to PDF, refer to Converting redline to PDF
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Saving redlines

You can save the redline as a Workshare Compare DeltaFile (WDF), which contains all 
three documents (original, modified and redline) as well as your ‘Accept’ and ‘Flag’ 
selections. You can also save just the redline as a DOC/DOCX, RTF, HTM, TXT or PDF 
file or you can save the redline as a track change document.

You can save the redline to your DMS/CRM, SharePoint or locally. The following
procedure describes how to save to NetDocuments as an example.

To save the redline:

1. Click Save As and then Comparison document in the Home tab (or quick access 
toolbar or File menu). The following dialog is displayed. 

2. Select whether you want to save the comparison as a new document or attach it to 
the original or modified documents.
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3. Click OK. The NetDocuments Save As dialog is displayed. 

Notes:
If you are not working with a DMS or SharePoint, the LocalStore Save As dialog is 
displayed.

If you click Cancel in the DMS save dialog, a message is displayed asking if you 
would like to save the redline locally.

Tip! If you are working with a DMS or SharePoint but both documents compared 
are local documents, then you can press the Shift key while clicking Save and the 
LocalStore Save As dialog is displayed.

4. Browse to the location where you want to save the comparison and modify the 
name of the comparison as required.
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5. From the Save as type dropdown list, select the format for the saved file from the 
following:

Workshare DeltaFile 
(*.wdf)

Saves both the redline and the source documents, as 
well as your ‘Accept’ and ‘Flag’ selections, as a 
Workshare DeltaFile. This file can only be opened in 
Workshare Compare.

Word Document 
(*.doc/*.docx)

Saves the redline as a Microsoft Word file. The source 
documents and your ‘Accept’ and ‘Flag’ selections are 
not saved.

Text Only (*.txt) Saves the redline as a text file. The source documents 
and your ‘Accept’ and ‘Flag’ selections are not saved.

Rich Text Format 
(*.rtf)

Saves the redline as an RTF file. The source 
documents and your ‘Accept’ and ‘Flag’ selections are 
not saved.

HTML Document 
(*.htm)

Saves the redline as a HTML document. The source 
documents and your ‘Accept’ and ‘Flag’ selections are 
not saved.

Adobe Acrobat File 
(*.pdf)

Saves the redline as a PDF file. The source 
documents and your ‘Accept’ and ‘Flag’ selections are 
not saved.

Adobe Acrobat
PDF/A File (*.pdf)

Saves the redline as a PDF/A file. The source 
documents and your ‘Accept’ and ‘Flag’ selections are 
not saved.

6. Click Save.

Saving redline as track change document

You can also save the redline as a Microsoft Word file that shows the changes as track 
changes.

Note: The converting to track changes functionality is only enabled, if the Enable 
Convert to Track Change functionality parameter (Comparison > User Interface
category) in the Workshare Configuration Manager is selected.

To save redlines with changes as track changes:

1. Click Save As and then Word document with Track Changes in the Home tab (or 
quick access toolbar or File menu).

2. Select whether you want to save the comparison as a new document or attach it to 
the original or modified documents.

3. Click OK. The NetDocuments Save As dialog is displayed. 

4. Browse to the location where you want to save the track change document and 
modify the name of the document as required.
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5. Click Save. The redline is saved as a Microsoft Word document with the changes 
indicated by track changes.

When you open the saved file in Microsoft Word, the changes are displayed as track 
changes.

Opening saved Workshare DeltaFiles

When a comparison has been saved as a Workshare DeltaFile, you can open it from 
Workshare Compare.

To open a saved comparison:

1. Click Open Comparison from the File menu. An Open dialog is displayed.

Note: Clicking Open when you work with a DMS/CRM or SharePoint accesses the 
DMS/CRM or SharePoint. To open from a local or network drive, hold the Shift key 
down when clicking Open or click Cancel in the DMS/CRM or SharePoint open 
dialog.

2. Navigate to the location where the comparison is saved and select the WDF file 
you want to open.

3. Click Open. The selected comparison is opened in Workshare Compare. The 
source documents and the redline are displayed as well as any ‘Accepted’ and 
‘Flagged’ selections you made in the Change Summary window.

Sending by email

Workshare Compare integrates with your email system so you can send redlines as well 
as the original and modified documents as email attachments. You can send the entire 
redline or just the pages that include changes. You can also send the redline as a 
Microsoft Word file that shows the changes as track changes. This is useful if the recipient 
does not have Workshare Compare.

To send a redline as a PDF:

Click Email and then Attach as PDF in the Home tab (or File menu). The redline is 
converted to PDF and a new email window is opened with the PDF attached.

To send changed pages as a PDF:

Click Email and then Attach as PDF (only pages with changes) in the Home tab (or File 
menu). The changed pages in the redline are converted to PDF and a new email window 
is opened with the PDF attached.
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To send multiple files:

1. Click Email and then More email options in the Home tab (or File menu). The 
Email Comparison Documents dialog is displayed.

2. Select the files to send by selecting one of the following options:

 Individual documents included in this comparison

Selecting this option displays a list of the documents included in the comparison 
in the lower pane. Select the checkboxes to the left of the documents you want 
to send. You can click in the Document Name fields and modify the names of 
the documents.

Note: The original and modified documents are sent in Microsoft Word format and 
the redline is sent by default as a PDF. Click in the Document Format field of the 
redline to change the default format, for example, to RTF.
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 Workshare Compare’s internal file format (DeltaFile)

Selecting this option sends the compared documents as a DeltaFile which 
contains all three documents (original, modified and redline) as well as your 
‘Accept’ and ‘Flag’ selections. A DeltaFile can only be opened in Workshare 
Compare. The file extension for a DeltaFile is WDF.

Tip! Click in the Document Name field to change the name of the redline.

 Multiple redlines

Selecting this option lists all the redlines currently open (each in a different tab 
in the Workshare Compare window). Select which ones you want to attach to 
your email. You can change the name of the redline in the Document Name 
field and select a different format for the redline from the Document Format 
field.

3. If you only want to include the pages with changes in the redline, select the Only 
include pages…. checkbox. This is only available when you are sending the 
redline as a PDF.

4. Click OK. An email message window is displayed with the selected files as 
attachments.

5. Enter the recipient(s) name and any other text you want to include and click Send.

Sending by email as track change document

You can also send the redline as a Microsoft Word file that shows the changes as track 
changes.

Note: The converting to track changes functionality is only enabled, if the Enable 
Convert to Track Change functionality parameter (Comparison > User Interface
category) in the Workshare Configuration Manager is selected.
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To send redlines with changes as track changes:

Click Email and then Attach as Word document with Track Changes in the Home tab 
(or File menu). The redline is saved as a Microsoft Word document with the changes 
indicated by track changes and a new email window is opened with the Word document 
attached.

Printing redlines

You can print the entire redline or just the pages that have changes, as well as either of 
the source documents.

To print the comparison documents:

1. Click Print in the Home tab (or File menu) and then one of the following options:

 Comparison only

 Comparison + Modified

 Comparison + Modified + Original

The Print dialog is displayed.

2. Select from the standard print options in the usual way.

3. If you are printing to a black and white printer, select the Print Redline in black 
and white checkbox, as color text may not appear clearly when printing in black 
and white. 

4. If you only want to print pages of the redline that include changes, select the Only 
print pages with changes checkbox.
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5. Click OK.

Note: You can preview the printed version of the redline, original or modified document 
using the Print Preview options in the File menu.

Converting redline to PDF

You can convert the redline to PDF and save it locally or in your DMS or you can attach 
the PDF to an email and send.

To convert a redline to PDF:

1. Click PDF in the Home tab. The Convert to PDF dialog is displayed.

Note: This dialog displays slightly differently depending on whether you are 
working with a document saved in your DMS/CRM.
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2. Select whether you want to convert the redline to PDF or PDF/A.

3. If required, click Configure PDF Security to set PDF security options as well as 
metadata cleaning options. The following dialog is displayed.

4. If you selected PDF, you can select one or more of the security options as required:

 Prevent printing: Prevents recipients from printing the PDF document.

 Prevent editing of text: Prevents recipients with Adobe Distiller from editing 
the PDF document.

 Prevent the copying of text and/or graphics: Prevents recipients from 
copying graphics or text directly from the PDF document.

 Prevent comments being added: Prevents recipients with Adobe Distiller from 
adding comments to the PDF document.
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5. If you selected PDF or PDF/A, click Cleaning Options to specify what metadata to 
remove before converting the redline to PDF.

6. Select metadata elements as required. For a full description of all the metadata 
elements, refer to the Workshare Professional User Guide.

7. Click OK.

8. If you selected PDF, you can set a password to protect the PDF by entering the 
password twice in the Password protection area. When a password is specified, 
the recipient can only open the PDF after entering this password.

9. Click Apply.

10. In the Convert to PDF dialog, when working with a DMS, select whether to save the 
PDF as a new document or as a related document or locally.
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11. If you want to create a PDF of part of the redline only, select the Pages radio 
button and specify a page range. 

Note: You can also PDF individual pages by specifying the pages (separated by 
commas) in the Pages field.

12. If required, click Preview to view the document as a PDF.

13. To open the PDF once it has been created, select the Open PDF once created 
checkbox.

14. To attach the PDF to a new email message once it has been created, select the 
Email PDF as an attachment checkbox.

15. Click Create. The Save as dialog is displayed.

16. Specify the name and location for the PDF file and click Save. The redline is 
converted to PDF.
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Chapter 3: Comparing Presentations
This chapter describes Workshare Compare for PowerPoint, a standalone application that 
enables you to compare two presentations. It includes the following sections:

 Introducing Compare for PowerPoint, page 65, introduces the Workshare 
Compare for PowerPoint application and explains how to launch it.

 Comparing Presentations, page 65, describes how to compare a presentation
against an earlier version of the presentation or against a different presentation
using Workshare Compare for PowerPoint.

 Workshare Compare for PowerPoint Main Window, page 72, describes the 
Workshare Compare for PowerPoint environment and provides an overview of the 
functionality available.

 Working with Comparisons, page 78, describes the tools available to you when 
working with the compared presentation after a comparison.
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Introducing Compare for PowerPoint

Note: This chapter describes how to compare PowerPoint presentations. The 
comparison of Word documents and PDF files is described in Chapter 2 and the 
comparison of Excel spreadsheets is described in Chapter 4.

Workshare Compare for PowerPoint is a presentation comparison tool designed to make 
the process of editing and revising presentations as fast and efficient as possible. 
Workshare Compare for PowerPoint enables you to compare Microsoft PowerPoint
presentations and immediately see any differences between them. In one view, you can 
see both the original and modified presentations with the differences clearly marked as 
well as a written summary of the changes and color-coded thumbnails of the slides 
showing which slides were modified, deleted, and inserted. Presentations stored in your 
DMS or CRM, locally or on your network can be compared.

To make the review easier, you can select different “comparison themes” to define exactly 
what is compared as well as how changes are displayed.

What is compared?

Workshare Compare for PowerPoint provides a comprehensive comparison of two 
Microsoft PowerPoint presentations and can detect the following changes:

 Slide moves, insertions and deletions

 Text moves, insertions and deletions

 Text formatting changes

 Image and object content changes

 Text box changes

 Hyperlink changes

 Speaker note changes

 Slide background changes

Comparing Presentations

You can compare your original presentation against a previous version of the presentation
or against another presentation entirely. For example, there may be ten versions of a 
presentation in your DMS. You can open version 10 and compare it against version 5.

You can launch Workshare Compare for PowerPoint and perform comparisons from within 
Microsoft PowerPoint, from your desktop, from right-click options or from an email and 
each of these scenarios is described in the following sections.
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Launching PowerPoint comparisons from Microsoft 
PowerPoint

In this scenario, you first open your presentation in Microsoft PowerPoint.

To compare presentations:

Click Compare in the Litera tab. The Select Presentations for Comparison dialog is 
displayed with the open presentation in the Modified Presentation field. Select the 
presentation to compare it against as described in Launching PowerPoint comparisons 
from your desktop.

Launching PowerPoint comparisons using right-click 
options

You can launch Workshare Compare for PowerPoint by right-clicking presentations in File 
Explorer or in your DMS (iManage FileSite/DeskSite and OpenText). 

 Right-click the original presentation and select Compare with Workshare. The 
Select Presentations for Comparison dialog is displayed with the selected 
presentation in the Original Presentation field. Select the file to compare it against 
as described in Launching PowerPoint comparisons from your desktop.

 Select the original and modified presentations, right-click and select Compare with 
Workshare. The Select Presentations for Comparison dialog is displayed with the 
selected presentations in the Original Presentation and Modified Presentation
fields. Continue as described in Launching PowerPoint comparisons from your 
desktop.

Note: You cannot launch Workshare Compare for PowerPoint from SharePoint or 
Worldox using right-click options, from NetDocuments using Send to Application, or from 
the iManage Work 10 browser interface using the kebab (context) menu.
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Launching PowerPoint comparisons from email

You can launch Workshare Compare for PowerPoint from the dropdown context menu of 
an attachment to an email or using the Compare button in the Litera tab.

 Select one (or two attachments), click the dropdown and click Compare 
Attachments.

The Select Presentations for Comparison dialog is displayed with the attachment in 
the Modified Presentation field. Continue as described in Launching PowerPoint 
comparisons from your desktop.

 With an email selected in your inbox, click Compare in the Litera tab. If the email 
doesn’t include attachments, the Compare button is disabled. If the email includes 
one or two PowerPoint attachments, the Select Presentations for Comparison
dialog is displayed with the attachments selected. If the email contains more than 
two attachments, the following dialog is displayed:
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Select the attachments you want to compare and click Continue. The Select 
Presentations for Comparison dialog is displayed with the attachments selected. 
Continue as described in Launching PowerPoint comparisons from your desktop.

Note: If you select attachments that can’t be compared for example, a DOCX and 
an PPTX, the Continue button will be disabled.

Launching PowerPoint comparisons from your desktop

In this scenario, you launch Workshare Compare for PowerPoint as a standalone 
application from your desktop or the Start menu. You then select the presentations you 
want to compare. 

To compare presentations:

1. Double-click the Workshare Compare for PowerPoint shortcut on your desktop or 
select Workshare Compare for PowerPoint from the Start menu. The Select
Presentations for Comparison dialog is displayed:
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Note: Click Cancel if you want to close the Select Presentations for Comparison 
dialog without running a comparison. For example, if you just want to open the
Workshare Compare for PowerPoint window in order to open a previously saved
comparison.

2. Select the original presentation you want to compare:

 Drag the file over the Original Presentation field, or

 Click to the right of the Original Presentation field, navigate to the 
presentation location in your local file system, SharePoint or DMS/CRM and
click Open. 

The selected presentation is displayed in the Original Presentation field.

Tip! If you want to compare a recently used file, click the dropdown in the 
Original Presentation and Modified Presentation fields and select the 
presentations you want to compare. These lists contain the last 8 files you have 
used.

When working with iManage, and the selected file has versions, the recent files list 
can also include these versions. In this way, you can easily compare different 
versions of your iManage presentations. 

3. Select the presentation you want to compare with the original presentation:

 Drag the file over the Modified Presentation field, or

 Click to the right of the Modified Presentation field, navigate to the 
presentation location in your local file system, SharePoint or DMS/CRM and 
click Open. 

The selected presentation is displayed in the Modified Presentation field.

Tip! To swap the original and modified presentations, click .

4. From the Select Comparison Theme dropdown list, select the comparison theme
you want to use. Comparison themes contain a set of parameters that define 
exactly what is compared as well as how changes are displayed. You can select 
from the standard comparison themes provided with Workshare Compare for 
PowerPoint or you can create and customize your own comparison themes. Refer 
to Appendix B: Configuring Comparison Themes for further information.
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Note: Clicking to the right of the Select Comparison Theme field displays 
the Comparison Themes Manager where you can create, modify and delete 
comparison themes. For a full description refer to Appendix B: Configuring 
Comparison Themes.

5. Click OK. The comparison process is launched and a progress dialog is displayed.

When the comparison is complete, the Workshare Compare for PowerPoint window is 
displayed showing the changes between the selected presentations. For a full description 
of the Workshare Compare for PowerPoint interface, refer to Workshare Compare for 
PowerPoint Main Window. For a description of how to navigate between the changes and 
review the changes in your compared presentations, refer to Working with Comparisons.

Workshare Compare for PowerPoint from the command 
line

Comparisons can be run from the command line. Running DeckCompare.exe /? displays
a summary of the available command line options when the program starts up. 
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The command line parameters are as follows:

Parameter Definition

/load <file> Loads an existing comparison file (*.wcfp).

/original <file> Selects an existing original presentation file for comparison.

/modified <file> Selects an existing modified presentation file for comparison.

/theme <name> Selects the named comparison theme.

/save<file> For an initial comparison from the command line, specifies a file to 
save the comparison to.

/report <file name> Creates a report of the comparison that includes the original and 
modified slide as well as a list of the changes per slide pair.

/showselector Displays the Select Presentations for Comparison dialog enabling 
you to perform a new comparison.

/resetwindowlayout Displays the main window in its default layout.

/noapply Turns off the apply change functionality for the comparison.

/? Shows the command line options.

If /load is used, or both /original and /modified, the Select Presentations for Comparison
dialog is bypassed. Otherwise, the dialog is pre-populated with whichever of /original, 
/modified and /theme are specified.
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Workshare Compare for PowerPoint Main 
Window

The Workshare Compare for PowerPoint main window enables you to view the results of a 
comparison between an original presentation and a modified presentation. You can view 
(in one work area) both source presentations, slide thumbnails and a summary of the 
changes between the two source presentations.

The ribbon changes according to the selected tab. In the above example, the Home tab is 
selected so the Home ribbon is displayed.

The different areas of the Workshare Compare for PowerPoint work area are described in 
the following sections.
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File menu

The File menu includes the following options:

Option Description

Open Enables you to open a saved comparison. Comparisons are saved as 
Workshare .wcfp files. Refer to Opening saved Workshare Compare 
for PowerPoint files.

Save Enables you to save the current comparison. Refer to Saving 
comparisons.

Save As Enables you to save a saved comparison with a new name.

Print Enables you to print a comparison report showing the changes found 
by the comparison. Refer to Printing comparison reports.

About Displays version information about Workshare Compare for 
PowerPoint.

Exit Closes Workshare Compare for PowerPoint.

Quick access toolbar

The quick access toolbar provides one-click access to functionality. By default, the Save
and New buttons are available. Click the arrow to the right of the quick access toolbar and 
select Minimize the Ribbon to hide the ribbon.

Note: To change the commands that appear in the quick access toolbar, right-click in the 
ribbon and select Customize Quick Access Toolbar. 

Home tab

The Home ribbon enables you to move between slides and changes, as well as apply and 
edit comparison themes.
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The options are described in the following table.

Section Option Description

Comparison New Opens the Select Presentations for Comparison dialog
enabling you to perform a new comparison. Refer to 
Comparing Presentations.

Reports Save Enables you to save the current comparison as a PDF 
or WCFP file. Refer to Saving comparisons.

Print Enables you to print a comparison report showing the 
changes found by the comparison. Refer to Printing 
comparison reports.

Create Enables you to create a comparison report showing 
the changes found by the comparison. Refer to 
Creating comparison reports.

Change 
Navigation

Show 
Changes

Displays only slides that include changes, hiding those 
slides that have not changed.

Change 
Summary

Displays/hides the Change Summary area. Refer to 
Change Summary area.

Current Slide 
Only

Displays only changes relating to the currently 
displayed slide in the Change Summary area.

Find Change Enables you to search for specific text in the Change 
Summary area. Refer to Searching changes.

Previous Navigates to the previous change in the Change 
Summary area. The change in also highlighted in the 
Slide View area. Refer to Navigating between 
changes.

Next Navigates to the next change in the Change Summary 
area. The change in also highlighted in the Slide View 
area. Refer to Navigating between changes.

First Navigates to the first change in the Change Summary 
area. The change in also highlighted in the Slide View 
area. Refer to Navigating between changes.

Last Navigates to the last change in the Change Summary 
area. The change in also highlighted in the Slide View 
area. Refer to Navigating between changes.

Comparison 
Themes

Select Enables you to select an alternative comparison theme 
from the dropdown list. This comparison theme is then 
applied to the current comparison. Refer to Applying 
Comparison Themes.



Comparing Presentations

75

Section Option Description

Edit Opens the Comparison Themes Manager from where 
you can modify existing comparison themes as well as 
create new comparison themes. Refer to Customizing 
Comparison Themes.

More tab

The More ribbon enables you to change the display of the different areas in the main 
window.

The options are described in the following table.

Section Option Description

Original/
Modified

Swap Swaps the original and modified presentations and re-
runs the comparison. Refer to Swapping the source files.

Slide/Views Horizontal Displays the original and modified presentations side by 
side in the Slide View area.

Vertical Displays the original presentation above the modified 
presentation in the Slide View area.

Tabbed Displays the original and modified presentations in tabs in 
the Slide View area.

Zoom Zoom Enables you to change the magnification of the original 
and modified presentations in the Slide View area. There 
are also zoom controls on the right side of the status bar. 

Fit Width Fits the original and modified presentations to the width of 
the Slide View area.
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Slide Selector area

The Slide Selector area displays thumbnail images of the slides in the original and 
modified presentations. The slides have different colored borders so you can see at a 
glance when a new slide has been inserted or a slide has been deleted or includes 
changes. The border colors are as follows:

Yellow The content of the slide has changed. 

Green The slide has moved its position (the new position is indicated).

Red The slide has been deleted.

Blue The slide is a new inserted slide.

Slides that have not changed in any way have no colored border.

In addition, the following icons in between the slide pairs indicate which slide pairs are 
different and which are the same:

Both slides in the slide pair are the same.

There are differences between the slides in the slide pair.

The slides currently selected in the Slide Selector area are displayed in the Slide View 
area.

The Slide Selector area is by default positioned down the left side of the Workshare 
Compare for PowerPoint environment. It can also float over the other windows. Click the 

and select from the following options:

Tip! You can also use the to auto-hide the Slide 
Selector area.

Slide View area

The Slide View area displays both presentations that have been compared and clearly 
indicates the changes on each. The presentations are synchronized so that if you select a 
particular slide in the Slide Selector area or a particular change in the Change Summary 
area then that slide or change is shown in both the original and modified presentations.

Changes are marked according to the comparison theme applied to the comparison. For 
example, deleted text could be red and struck through and added text could be blue and 
underlined.



Comparing Presentations

77

Change Summary area

The Change Summary area provides a list of all the changes between the original and 
modified presentations in the order that they occur. Changes can be displayed for all slides 
or on a slide by slide basis. Selecting a change in the Change Summary area displays the 
slides that include the change in the Slide View area and highlights the slides in the Slide 
Selector area. The change that is selected is highlighted in light green in the Slide View 
area.

The color and formatting of the change in the Change Summary area and in the Slide View 
area is determined by the comparison theme applied to the comparison. For a full 
description of comparison themes, refer to Appendix B: Configuring Comparison Themes.

You can select changes in the Change Summary area using the mouse or using buttons in 
the Home tab.

The following information is shown for each change in the Change Summary area:

Slide 
Number

The number of the original slide and the number of the modified slide in 
the comparison.

Change 
Numbers

The number of the change in the comparison. A change may have two 
numbers when it includes two actions. For example, a deletion and an 
addition.

Type The type of change, such as replaced text, deleted text box, moved 
slide.

Details Details of the change. 

The icons to the left of each change indicate the type of change as follows:

Replacements Formatting changes

Insertions Slide move source

Deletions Slide move destination

The Change Summary area is by default positioned across the bottom of the Workshare 
Compare for PowerPoint environment. It can also float over the other windows. Click the 

and select from the following options:

Tip! You can also use the to auto-hide the Change 
Summary area.
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Working with Comparisons

Navigating changes

After performing a comparison, you can review the result of the comparison and consider 
the changes between the original and modified presentations. You can move between 
changes by navigating between slides or by navigating between changes. All areas of the 
Workshare Compare for PowerPoint window are synchronized.

Navigating between slides

Clicking slides in the Slide Selector area displays the selected slides in the Slide View area 
and shows the changes relating to that slide in the Change Summary area.

The following icons in between the slide pair in the Slide Selector area indicate whether 
the slide has changed or not:

The slide has not changed. 

The slide has changed.

In addition, the thumbnail images of the slides in the Slide Selector area have different 
colored borders so you can see at a glance when a new slide has been inserted or a slide 
has been deleted or a slide includes changes. The border colors are as follows:

Yellow The content of the slide has changed. 

Green The slide has moved its position (the new position is indicated).

Red The slide has been deleted.

Blue The slide is a new inserted slide.

Slides that have not changed in any way have no colored border.
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Navigating between changes

Clicking a change in the Change Summary area displays the slides that include the 
change in the Slide View area and highlights the slides in the Slide Selector area. The 
change that is selected is highlighted in light green in the Slide View area. 

The color and formatting of the change in the Change Summary area and in the Slide View 
area is determined by the comparison theme applied to the comparison. For a full 
description of comparison themes, refer to Appendix B: Configuring Comparison Themes.

You can also move between changes in the Change Summary area using the First, Last, 
Previous and Next buttons in the Change Navigation group of the Home tab.

Note: By default, the Change Summary area provides a list of all changes occurring on 
all slides in the compared presentations. If you want to display just the changes that 
occur on the displayed slide, click the Current Slide Only button in the Change 
Navigation group of the Home tab.

The Change Summary area indicates the type of change as well as details of the change 
itself, such as the specific text that has been inserted or deleted.
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Searching changes

You can search for specific text in the Change Summary area. Workshare Compare for 
PowerPoint can search all text in the Change Summary area or just the text that has been 
changed (inserted, deleted or moved).

To search changes:

1. Click the Find Change button in the Change Summary group of the Home tab. 
The Find Changes dialog is displayed.

2. In the Find what field, enter the text that you want to look for.

3. Select the Match case checkbox if you want to search for identical text in the same 
case.

4. Select the Search changed text only checkbox if you want to search only the text 
that has been changed.

5. Click Find. Workshare Compare for PowerPoint searches for the specified text. 
When it is found, the text is highlighted in the Change Summary area and the 
relevant slide is shown in the Slide Selector area and Slide View area.

6. Click Find Next to search for further occurrences of the specified text. Click Find 
Previous to return to the previously found instance.

7. Click Close to close the Find Changes dialog.
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Swapping the source files

You can re-run a comparison exchanging the original presentation for the modified 
presentation and vice versa. For example, if you selected Presentation A as the original 
presentation and Presentation B as the modified presentation, Workshare Compare for 
PowerPoint shows the changes made to Presentation A to produce Presentation B. You 
can then swap the presentations so that Presentation B is now the original and 
Presentation A is the modified presentation. Workshare Compare for PowerPoint
automatically re-runs the comparison and shows the changes made to Presentation B to 
produce Presentation A.

To swap the source presentations:

Click Swap in the More tab. Workshare Compare for PowerPoint automatically runs a new 
comparison, using the modified presentation as the original presentation and the original 
presentation as the modified presentation. The new comparison is displayed in the 
Workshare Compare for PowerPoint window replacing the previous comparison.

Saving comparisons

You can save a comparison as a PDF file or a WCFP (Workshare Compare for 
PowerPoint) file in your DMS or CRM, locally or on your network.

The PDF file can include the original and modified slides and/or a list of the changes per 
slide pair. It can also just include the slides that have changes.

Note: The layout and contents of the saved PDF are determined by the Compare for 
PowerPoint – Default report layout and Compare for PowerPoint – Include 
unchanged slides parameters (Comparison > Administration category) in the 
Workshare Configuration Manager.

The WCFP file can be opened in Workshare Compare for PowerPoint.

To save a comparison:

1. Click Save in the File menu or quick access toolbar. The Save As dialog is 
displayed.

2. Select whether to save the comparison as a WCFP or PDF file.

3. Navigate to the location where you want to save the file and enter a name for the 
file.

4. Click Save.

Opening saved Workshare Compare for PowerPoint files

When a comparison has been saved as a Workshare Compare for PowerPoint file, you 
can open it from the Workshare Compare for PowerPoint main window.
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To open a saved comparison:

1. Click Open in the File menu. An Open dialog is displayed.

Note: If Workshare Compare for PowerPoint is not open, launch it in the usual 
way and click Cancel in the Select Presentations for Comparison dialog so that no
initial comparison is performed and a blank Workshare Compare for PowerPoint
main window is displayed.

2. Navigate to the location where the comparison is saved and select the .wcfp file you 
want to open.

3. Click Open. The selected comparison is opened in Workshare Compare for 
PowerPoint. 

Creating comparison reports

After you have run a comparison, you can create a report showing the changes found by 
the comparison. The PDF comparison report can include both the original and modified 
slides as well as a list of changes per slide pair or you can select to include just the slide 
pair or just the list of changes.

To create a comparison report:

1. Click Create in the Home tab. The Create Comparison Report dialog is displayed.

2. In the Choose Report Layout area, select what you want to include in the report 
by selecting one of the following options:

 Full Comparison Report: Includes the original and modified slide as well as a 
list of the changes per slide pair.
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 Change Summary Only: Includes the list of changes in table format for each 
slide pair.

 Slide View Only: Includes the original and modified slides.

3. Select the Include unchanged slides checkbox if you also want to include in the 
report slide pairs that didn’t have changes.

Note: To display the selected comparison report, click Preview.

4. Click Create.

5. In the save dialog, browse to a save location and enter a name for the report.

6. Click Save. The comparison report is generated and saved as a PDF in the 
specified location.

Printing comparison reports

After you have run a comparison, you can print a report showing the changes found by the 
comparison. The comparison report can include both the original and modified slides as 
well as a list of changes per slide pair or you can select to include just the slide pair or just 
the list of changes.

If you have created a comparison report already and saved it as a PDF (as described in 
Creating comparison reports) you can simply print the PDF in the usual way. The following 
procedure describes how to create and print a comparison report in one step.

To print a comparison report:

1. Click Print in the Home tab or File menu. The Print Comparison Report dialog is 
displayed.

2. In the Choose Report Layout area, select what you want to include in the report 
by selecting one of the following options:

 Full Comparison Report: Includes the original and modified slide as well as a 
list of the changes per slide pair.

 Change Summary Only: Includes the list of changes in table format for each 
slide pair.

 Slide View Only: Includes the original and modified slides.

3. Select the Include unchanged slides checkbox if you also want to include in the 
report slide pairs that didn’t have changes.

4. In the Printer area, select which printer to use.

5. In the Print Range area, select whether to include all slides or selected slides. 

6. In the Copies area, enter how many copies of the comparison report you want to 
print and select the Collate checkbox if collating of multiple copies is required.
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Note: To display the selected comparison report, click Preview. Note that the full 
report is displayed for preview even if a page range has been specified.

7. Click OK. The comparison report is created and printed as specified.
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Chapter 4: Comparing Spreadsheets
This chapter describes Workshare Compare for Excel, a standalone application that 
enables you to compare two spreadsheets. It includes the following sections:

 Introducing Compare for Excel, page 86, introduces the Workshare Compare for 
Excel application and explains how to launch it.

 Comparing Spreadsheets, page 86, describes how to compare a spreadsheet
against an earlier version of the spreadsheet or against a different spreadsheet
using Workshare Compare for Excel.

 Workshare Compare for Excel Main Window, page 92, describes the Workshare 
Compare for Excel environment and provides an overview of the functionality 
available.

 Understanding Changes, page 95, describes how changes are displayed in the 
comparison.

 Rendering Sets in Compare for Excel, page 101, describes how to create and 
modify the rendering sets applied to spreadsheet comparisons.

 Working with Comparisons, page 106, describes the tools available to you when 
working with the compared spreadsheet after a comparison.
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Introducing Compare for Excel

Note: This chapter describes how to compare Excel spreadsheets. The comparison of 
Word documents and PDF files is described in Chapter 2 and the comparison of 
PowerPoint presentations is described in Chapter 3.

Workshare Compare for Excel is a spreadsheet comparison tool designed to make the 
process of editing and revising spreadsheets as fast and efficient as possible. Workshare 
Compare for Excel enables you to compare Microsoft Excel spreadsheets and immediately
see any differences between them. The differences between each cell are clearly marked 
and a detailed summary of the change provided in a panel. To make the review easier, 
you can customize how the changes are highlighted within the comparison. Spreadsheets 
stored in your DMS or CRM, locally or on your network can be compared.

What is compared?

Workshare Compare for Excel provides a comprehensive comparison of two Microsoft 
Excel presentations and can detect the following changes:

 Cell insertions and deletions

 Cell merges and splits

 Changes to number values

 Text changes

 Changes to formulas

 Number format changes

 Changes to visual formatting in cells

 Changes to font formatting

Comparing Spreadsheets

You can compare your original spreadsheet against a previous version of the spreadsheet
or against another spreadsheet entirely. For example, there may be ten versions of a 
spreadsheet in your DMS. You can open version 10 and compare it against version 5.

You can launch Workshare Compare for Excel and perform comparisons from within 
Microsoft Excel, from your desktop, from right-click options or from an email and each of 
these scenarios is described in the following sections.
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Launching Excel comparisons from Microsoft Excel

In this scenario, you first open your spreadsheet in Microsoft Excel.

To compare spreadsheets:

Click Compare in the Litera tab. The file selection dialog is displayed with the open 
spreadsheet in the Modified field. Select the spreadsheet to compare it against as 
described in Launching Excel comparisons from your desktop.

Launching Excel comparisons using right-click options

You can launch Workshare Compare for Excel by right-clicking presentations in File 
Explorer or in your DMS. 

 Right-click the original spreadsheet and select Compare with Workshare. The file 
selection dialog is displayed with the selected spreadsheet in the Original field. 
Select the file to compare it against as described in Launching Excel comparisons 
from your desktop.

 Select the original and modified spreadsheets, right-click and select Compare with 
Workshare. The file selection dialog is displayed with the selected spreadsheets in 
the Original and Modified fields. Continue as described in Launching Excel
comparisons from your desktop.

Note: You cannot launch Workshare Compare for Excel from SharePoint using right-click 
options, or from the iManage Work 10 browser interface using the kebab (context) menu.
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Launching Excel comparisons from email

You can launch Workshare Compare for Excel from the dropdown context menu of an 
attachment to an email or using the Compare button in the Litera tab.

 Select one (or two attachments), click the dropdown and click Compare 
Attachments.

The file selection dialog is displayed with the selected spreadsheet in the Modified 
field. Continue as described in Launching Excel comparisons from your desktop.

 With an email selected in your inbox, click Compare in the Litera tab. If the email 
doesn’t include attachments, the Compare button is disabled. If the email includes 
one or two Excel attachments, the file selection dialog is displayed with the 
attachments selected. If the email contains more than two attachments, the 
following dialog is displayed:
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Select the attachments you want to compare and click Continue. The file selection
dialog is displayed with the attachments selected. Continue as described in 
Launching Excel comparisons from your desktop.

Note: If you select attachments that can’t be compared for example, a DOCX and 
an XLSX, the Continue button will be disabled.

Launching Excel comparisons from your desktop

In this scenario, you launch Workshare Compare for Excel as a standalone application 
from your desktop or the Start menu. You then select the spreadsheets you want to 
compare. 

To compare spreadsheets:

1. Double-click the Workshare Compare for Excel shortcut on your desktop or select 
Workshare Compare for Excel from the Start menu. The file selection dialog is 
displayed:

2. Select the original spreadsheet you want to compare:

 Drag the file over the Original field, or

 Click to the right of the Original field, navigate to the spreadsheet location
in your local file system, SharePoint or DMS/CRM and click Open. 
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The selected spreadsheet is displayed in the Original field.

Tip! If you want to compare a recently used file, drag the file from Recently 
opened files.

3. Select the spreadsheet you want to compare with the original spreadsheet:

 Drag the file over the Modified field, or

 Click to the right of the Modified field, navigate to the spreadsheet location 
in your local file system, SharePoint or DMS/CRM and click Open. 

The selected spreadsheet is displayed in the Modified field.

Tip! To swap the original and modified spreadsheets, click .

4. If you want to compare individual sheets, select the Select sheets to compare
radio button.

5. Select the sheet in your original spreadsheet and the sheet in your modified 
spreadsheet that you want to compare.
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6. To select what changes are detected and how they are displayed, select the 
rendering set to use. Rendering sets contain a set of parameters that define what 
is compared and how changes are displayed in the comparison. You can select 
from the standard rendering sets provided with Workshare Compare for Excel or 
you can create and customize your own rendering sets (described in Rendering 
Sets in Compare for Excel).

Note: Clicking Edit displays the Rendering Set Manager where you can create, 
modify and delete rendering sets. For a full description refer to Rendering Sets in 
Compare for Excel.

7. Click Compare. The comparison process is launched.

When the comparison is complete, the Workshare Compare for Excel window is displayed 
showing the changes between the selected spreadsheets. For a full description of the 
Workshare Compare for Excel interface, refer to Workshare Compare for Excel Main 
Window. For a description of how to navigate between the changes and review the 
changes in your compared spreadsheets, refer to Understanding Changes and Working 
with Comparisons.

Password-protected spreadsheets

Workshare can compare password-protected spreadsheets once you enter the password. 
After clicking Compare in the file selection dialog, you are prompted to enter the password 
for any password-protected files you have selected.

Enter the password for the spreadsheet and click Unlock. The comparison process is 
launched.
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Workshare Compare for Excel Main Window

The Workshare Compare for Excel main window enables you to view the results of a 
comparison between an original spreadsheet and a modified spreadsheet. 

The different areas of the Workshare Compare for Excel work area are described in the 
following sections.

File menu

The File menu includes the following options:

Option Description

New Opens the file selection dialog so you can start a new comparison. The 
existing open comparison will be closed. Refer to Comparing 
Spreadsheets.

Swap Swaps the original and modified spreadsheets and re-runs the 
comparison. Refer to Swapping the source files.
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Option Description

Export Enables you to save the current comparison as an Excel file showing 
the changes and including a change summary tab. Refer to Saving 
comparisons.

About Displays version information about Workshare Compare for Excel.

Close Closes the open comparison and Workshare Compare for Excel.

Home tab

The Home ribbon enables you to move between changes, as well as control what changes 
are shown.

The options are described in the following table.

Section Option Description

Comparison New Opens the file selection dialog so you can start a new 
comparison. The existing open comparison will be 
closed. Refer to Comparing Spreadsheets.

Swap Swaps the original and modified spreadsheets and re-
runs the comparison. Refer to Swapping the source 
files.

Export Enables you to save the current comparison as an 
Excel file showing the changes and including a change 
summary tab. Refer to Saving comparisons.

Style Show source 
formatting

Displays/hides the formatting applied to the original 
and modified spreadsheets, such as cell shades and 
font styles. Refer to Source formatting.

Change 
Type

Show direct 
changes only

Displays/hides indirect changes. Indirect changes are 
changes that occur as the result of a modification to a 
different cell. Refer to Direct and indirect changes.

Change 
Type Filters

Numbers Displays/hides changes to number values.

Text Displays/hides changes to text.

Formulas Displays/hides changes to formulas.

Cell changes Displays/hides whether cells have been inserted or 
deleted.
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Section Option Description

Cell merges Displays/hides whether cells have been merged or 
split.

Number 
format

Displays/hides changes to the number format applied 
to a cell.

Cell format Displays/hides changes to the visual formatting of a 
cell.

Font format Displays/hides changes to the font formatting of a cell.

Rendering 
Sets

Sets Enables you to select a different rendering set from the 
dropdown list and Workshare Compare for Excel 
automatically re-runs the comparison applying the 
selected rendering set. Refer to Rendering Sets in 
Compare for Excel.

Edit Opens the Rendering Set Manager where you can 
apply different rendering sets to a comparison and, if 
you have permission, you can add, edit and delete 
rendering sets. Refer to in Rendering Sets in Compare 
for Excel.

Legend Displays a description of the meaning of the colors 
used in the comparison.

Change 
Navigation

Previous Navigates to the previous change in the comparison. 
Refer to Navigate between changed cells.

Next Navigates to the next change in the comparison. Refer 
to Navigate between changed cells.

First change Navigates to the first change in the comparison. Refer 
to Navigate between changed cells.

Last change Navigates to the last change in the comparison. Refer 
to Navigate between changed cells.

Information Help Provides access to online help.

Comparison area

The comparison area clearly indicates the changes between the compared spreadsheets. 
Insertions, deletions and modifications are highlighted in different colors, depending on the 
rendering set applied to the comparison. 

Selecting a cell displays details about its changes in the Change details panel on the right.
You can select changes in the comparison using your mouse or the buttons in the Home 
tab.
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When several sheets have been compared, you can select a worksheet using the tabs at 
the bottom of the comparison.

Change details panel

The change details panel is displayed to the right of the comparison when a cell is 
selected. It provides details about the changes in the selected cell.

Each change is listed in its own card in the panel. The change type is displayed at the top 
of the card.

You can close the change details panel by clicking the close icon in the top right.

Understanding Changes

Changes are shown using a combination of color, formatting and text description and 
Workshare offers several ways to filter changes to help make review of your changes as 
easy as possible. You can also change the rendering set applied to the comparison to 
customize how the changes are highlighted within the comparison.

Source formatting

Source formatting is any formatting applied to the original and modified files. It includes 
effects such as:

 Cell shades

 Cell colors

 Cell borders

 Non-standard fonts

 Font colors

 Font underlines

 Font styles (italic, bold)

 Font effects (strikethrough, superscript, subscript)
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In the comparison, source formatting is turned off by default so it’s easier to see the 
changes.

A comparison with source formatting off The same comparison with source 
formatting on

To view the source formatting, click Show source formatting in the Home ribbon.

Change types

Direct and indirect changes

When a cell has changed, it can be useful to know if any other cells have also changed as 
a result.

Any change that has occurred as the result of a modification in the same cell is called a 
direct change. Any change that has occurred as the result of a modification to a different cell 
is called an indirect change.

For example, take a workbook that has a row full of formulas. If you insert a new row above 
the formula row, all the formulas are pushed down by one row. The change to these formulas 
is indirect. If you select one of the cells with a formula and modify the formula, the change 
is direct.
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In a Workshare comparison, the rendering set determines how changes are highlighted. For 
example, direct changes could be highlighted in yellow and indirect changes in green. 

Note: If a cell contains direct changes and indirect changes, it’s highlighted in the color 
specified for direct changes. 

Direct changes are always highlighted. Indirect changes are highlighted by default, but you 
can toggle them on and off by using the Show direct changes only button in the Home 
ribbon.

You can see all changes to a cell by selecting the cell (see Changes to a cell).

Change type filters

The change type filters let you focus on the types of changes that matter to you. By 
default, every type of change is highlighted in the comparison. Switch off highlighting of 
individual change types by deselecting them in the Home ribbon.

The following types of changes can be highlighted:

Type Description

Numbers Cells with number values that have changed. For example, “1” has 
changed to “2”.

Note: The number format of the cell can be any format, including 
General, Number, Text, Currency, etc. 

Text Cells with text values that have changed. For example, “January” has 
changed to “February”.

Where cells include text and numbers (e.g. “A1” is changed to “B2”), 
they will be marked as Text changes.
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Type Description

Formulas Cells with a formula that has changed.

Cell changes Cells that have been inserted or deleted. 

Cell merges Cells that have been merged or split. 

Number format Cells that have had a change to their number format. For example, 
the number format has been changed from “General” to “Currency”. 

This includes changes to the properties of the number format. For 
example, a cell with the Currency format has had the number of 
decimal places changed from “2” to “0”.

Cell format Cells that have had a change to the visual formatting, including the 
cell shade, color and border.  

Font format Cells that have had a change to the font formatting, including the font, 
font size, color, underline, style (italic, bold) and effect (strikethrough, 
superscript, subscript). 

Note: These checkboxes only change what information is highlighted in the comparison. 
If you select a cell, all changes to that cell will be displayed in the change details panel on 
the right, regardless of which change type filters are selected.

Toggle between changes

Where changes have been made to an overlaid object, such as charts, shapes, images, 
etc., you can toggle between the original and modified object.

This enables you to quickly and clearly see what has changed.
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Changes to a cell

You can dive into any cell to see all its changes. Select a cell and the changes are 
displayed in the change details panel on the right. 

Each change is listed in its own card in the panel. The change type is displayed at the top 
of the card and also whether it’s a direct or indirect change. You can clearly see what the 
cell contained in the original spreadsheet and what it contains in the modified spreadsheet.

Navigate between changed cells

The Change Navigation buttons in the Home ribbon enable you to move quickly through 
the changes in the comparison. 

There are four buttons:

 Previous: The previous change is highlighted.

 Next: The next change is highlighted.

 First change: The first change is highlighted.

 Last change: The last change is highlighted.
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Priorities for highlighting direct and indirect changes

If a cell contains direct changes and indirect changes, the direct change takes priority and 
the cell is highlighted in the color for direct changes.

Priorities for highlighting inserted and deleted cells

In cases where an inserted or deleted row intersects an inserted or deleted column, 
changes are displayed as follows:

 If an inserted column intersects with an inserted row, the cell displays as inserted
(blue, with this rendering set).

 If an inserted column intersects with a deleted row, the cell displays as deleted
(red, with this rendering set):

 If a deleted column intersects with an inserted row, the cell displays as deleted
(red, with this rendering set):

 If a deleted column intersects with a deleted row, the cell displays as deleted (red, 
with this rendering set):
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Rendering Sets in Compare for Excel

Rendering sets affect what changes are detected as well as how changes are displayed. 
Compare for Excel includes two default rendering sets or you may create your own.

Customizing what changes are detected

You can re-run a comparison changing specific options within the rendering set.

To re-run a comparison with different options:

1. In the Home tab, click Edit in the Rendering Sets group. The Rendering Set 
Manager is displayed.
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2. Modify the change types to compare in the What to compare tab. For example, 
deselect the Font format checkbox and Compare for Excel will not detect any 
changes to font formatting, including the font, font size, color, underline, style (italic, 
bold) and effect (strikethrough, superscript, subscript).

3. Do one of the following:

 Click Save as new and enter a name for the rendering set. 

Click Save and re-run. The new rendering set is saved and Compare for Excel 
re-runs the comparison using the new rendering set and displays the resulting 
comparison in the Workshare Compare for Excel main window.

 Click Save and re-run. The changes you made to the options are saved in the 
selected rendering set and Compare for Excel re-runs the comparison using the 
selected parameters and displays the resulting comparison in the Workshare 
Compare for Excel main window.

Customizing how changes are displayed

Applying a different rendering set

You can re-run a comparison using a different rendering set.

To re-run a comparison with a different rendering set:

1. In the Home tab, click Sets in the Rendering Sets group. A list of the currently 
defined rendering sets is displayed.
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2. Select the rendering set to apply.

Compare for Excel re-runs the comparison using the selected rendering set and displays 
the resulting comparison in the Workshare Compare for Excel main window.

Creating new rendering sets 

Compare for Excel includes two rendering sets. You can create additional rendering sets 
using the Rendering Set Manager.

To create a new rendering set:

1. In the Home tab, click Edit in the Rendering Sets group. The Rendering Set 
Manager is displayed.

2. Select a rendering set from the dropdown that you’ll use as a base for the new 
rendering set.

3. Select what you want compared by the rendering set in the What to compare tab.

 Formulas: Changes to formulas.

 Values (numbers and text): Changes to values in a cell – this could number 
values, such as “1” has changed to “2”, or text values, such as , “January” has 
changed to “February”.

 Number format: Changes to number formatting. For example, the number 
format has been changed from “General” to “Currency”. 

This includes changes to the properties of the number format. For example, a 
cell with the Currency format has had the number of decimal places changed 
from “2” to “0”.

 Font format: Changes to the font formatting, including the font, font size, color, 
underline, style (italic, bold) and effect (strikethrough, superscript, subscript). 

 Cell changes: Cells that have been inserted or deleted. 

 Cell format: Cells that have had a change to the visual formatting, including the 
cell shade, color and border.  

 Overlaid objects (charts, pictures, shapes and text boxes): Changes to any 
overlaid objects, including charts, pictures, shapes and text boxes.
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4. Select the How to display changes tab.

5. Select the colors (and styles) to use to identify the different types of changes in the 
comparison.
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6. Click Save as new. 

7. Enter a name for the new rendering set.

8. Click Save and re-run.

The new rendering set is saved and Compare for Excel re-runs the comparison using the 
new rendering set and displays the resulting comparison in the Workshare Compare for 
Excel main window.

The new rendering set is now available from the Sets dropdown:

Deleting rendering sets

You can delete rendering sets using the Rendering Set Manager. You must always have 
at least one rendering set and you cannot delete the rendering set applied to the current 
comparison.

To delete a rendering set:

1. In the Home tab, click Edit in the Rendering Sets group. The Rendering Set 
Manager is displayed.

2. Select the rendering set that you want to delete from the dropdown.
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Note: You cannot delete the rendering set currently applied to the open 
comparison. You would first have to return to the comparison and apply another 
rendering set.

3. Click Delete.

4. Click Delete. The rendering set is permanently deleted and no longer appears in 
the Sets dropdown.

Working with Comparisons

Swapping the source files

You can re-run a comparison exchanging the original spreadsheet for the modified 
spreadsheet and vice versa. For example, if you selected Spreadsheet A as the original 
spreadsheet and Spreadsheet B as the modified spreadsheet, Workshare Compare for 
Excel shows the changes made to Spreadsheet A to produce Spreadsheet B. You can 
then swap the spreadsheets so that Spreadsheet B is now the original and Spreadsheet A 
is the modified spreadsheet. Workshare Compare for Excel automatically re-runs the 
comparison and shows the changes made to Spreadsheet B to produce Spreadsheet A.

To swap the source spreadsheets:

Click Swap in the Home ribbon. Workshare Compare for Excel automatically runs a new 
comparison, using the modified spreadsheet as the original spreadsheet and the original 
spreadsheet as the modified spreadsheet. The new comparison is displayed in the 
Workshare Compare for Excel window replacing the previous comparison.
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Saving comparisons

You can quickly export your changes to a new Excel file that you can save and share. You 
can save the file in your DMS or CRM, locally or on your network. 

To export the comparison:

1. Click Export in the Home ribbon. The Export to Microsoft Excel dialog opens.

2. Select whether you want to export the Entire workbook or only some Selected 
sheets. 

3. If you choose Selected sheets, click inside the Select one or more sheets field 
and choose the sheets to export.
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4. By default, all of the following will be included in the comparison:

 Change type filters: All change type filters currently highlighted.

 Indirect highlights: All indirect changes.

 Source formatting: Source formatting from the original and modified files.

If you would like to exclude any of these options, deselect them.

5. If you don’t want the saved comparison to open once the export is complete, 
deselect the Open exported file checkbox.

6. Click Export. The Save As dialog opens.

7. Navigate to a save location.

8. In the File name field, enter a name for the new file.

9. Click Save. The comparison is exported as a new Excel file.

The last worksheet of the Excel file is the Change Report. It lists every change from the 
comparison (excluding any changes you chose not to include when you exported the 
comparison). To jump to a change, click its View option in the Link column. 

The other worksheets correspond to the worksheets in the original and modified files. 
Select a sheet to view its comparison.
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Chapter 5: Configuring Workshare
This chapter describes the Workshare Configuration Manager. It includes the following 
sections:

 Introducing the Workshare Configuration Manager, page 110, introduces the 
Workshare configuration utility.

 Accessing the Workshare Configuration Manager, page 110, describes how to 
access the Workshare Configuration Manager.

 Setting Parameters, page 112, describes how to set values for parameters in the 
Workshare Configuration Manager.
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Introducing the Workshare Configuration 
Manager

The Workshare Configuration Manager is a configuration utility that enables you to 
configure Workshare and the way it behaves as well as modify the configuration of the 
default profile (via the parameters in the Protection category). 

Note: A profile is a collection of policies. A policy is a set of parameters applied by 
Workshare Protect when determining content risk.

Administrator Mode and User Mode

The Workshare Configuration Manager has two modes as follows:

 Administrator Mode: This mode is for administrators to make changes to the 
default settings on the local machine. Settings made are saved in 
HKEY_LOCAL_MACHINE in the Registry. As a user you will only have access to 
Administrator mode if you have Administrator rights.

 User Mode: This mode is for users to make changes to the Workshare 
configuration to suit their own personal preferences on the local machine. Other 
users could log in and they would not have the same configuration settings. 
Settings made are personal to the user and saved in HKEY_CURRENT_USER in 
the Registry.

Note: Your system administrator may have restricted the rights of users to modify 
configuration parameters by locking individual parameters so that users cannot override 
the setting. If you have restricted access rights and have special requirements for 
configuration, please speak to your system administrator.

Accessing the Workshare Configuration 
Manager

The Workshare Configuration Manager can be accessed from within Microsoft Office or 
from the Start menu.
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To access the Workshare Configuration Manager from Microsoft Word:

In an open document, click Options in the Litera tab or from the Start menu, select 
Workshare Configuration (User Mode). The Workshare Configuration Manager opens in 
User Mode.

Note: In User Mode, the state of the options reflects the settings in 
HKEY_CURRENT_USER in the Registry.

The configuration parameters for Workshare are grouped into categories and sub-
categories. Click a sub-category to display its parameters. The different sub-categories 
and their parameters are described in a separate guide - Workshare Configuration 
Options.

Searching parameters

If you know the name of a parameter (or part of its name) but not its location, you can 
search the Workshare Configuration Manager using the search box on the top right.
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Click the parameter in the results list and the relevant category and sub-category are
displayed in the Workshare Configuration Manager.

Setting Parameters

Most parameters in the Workshare Configuration Manager are set by selecting or 
deselecting a checkbox. There are also some that require you to enter a value in a text 
box.

To specify parameters:

1. In the Workshare Configuration Manager, select a category and then a 
sub-category.

2. Set a value for a parameter by selecting or deselecting the checkbox, selecting an 
option from a dropdown list or entering a value in a text box.

The icon to the right of a parameter indicates that the parameter value has 
been changed.

Note: When parameters have been locked by your administrator, the parameter 
will be disabled and a lock symbol will appear to the left of the parameter. You 
cannot change locked parameters.

3. Continue to select categories and sub-categories and specify parameters as 
required.
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4. Click Apply to save your settings. A confirmation message is displayed once the 
settings have been saved.

5. Click OK and restart all Microsoft Office applications.

Note: The different sub-categories and their parameters are described in the Workshare 
Configuration Options guide.
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Appendix A. Configuring Rendering 
Sets
This appendix describes how to configure rendering sets for Workshare Compare and 
apply them to a comparison. It includes the following sections:

 Introducing Rendering Sets, page 115, introduces Workshare rendering sets and 
describes how they determine the look of a redline.

 Accessing the Rendering Sets Manager, page 116, describes how to access the 
Workshare Rendering Sets Manager.

 Customizing Rendering Sets, page 119, describes how to create your own 
rendering sets as well as modify and delete existing rendering sets.

 Rendering Set Parameters, page 120, provides a detailed description of all the 
parameters included in rendering sets.

For a description of how to configure rendering sets when comparing Excel files, refer to 
Rendering Sets in Compare for Excel.
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Introducing Rendering Sets

Workshare Compare uses colors and different formats in the redline to enable you to see 
the changes that have been made to the documents.

For example, the following indications can be used:

 Deletions in red with a strikethrough

 Insertions in bright blue with a double underline

 Moved or cut text in green with a strikethrough

 Pasted (copied) text in green with a double underline

 Moved deletions in salmon pink with a strikethrough

The colors and formats adopted depend on the rendering set applied to the comparison. 
Workshare Compare includes several different rendering sets that you can apply as 
required or you can modify these rendering sets or create your own rendering set.

Note: It is general practice that your system administrator will have been involved in 
creating a set of standard rendering sets for your company to use and may have 
restricted the rights of users to create, delete or modify their own rendering sets. If you 
have restricted access rights and have special requirements for rendering sets, please 
speak to your system administrator.

Where are rendering sets stored?

By default, rendering sets are stored in the following locations:

 The default rendering sets included with Compare are machine-wide rendering sets 
and are stored in a shared documents folder at the following location: C: Users > 
Public > Public Documents > Workshare > Rendering.

 Any further rendering sets created by users are personal rendering sets and are 
stored in C: Users > (user name) > My Documents > Workshare > Rendering. This 
can be changed by an administrator in the Default location rendering set
parameter in the Workshare Configuration Manager (Comparison > 
Administration category).

You can store rendering sets at other locations but you must specify the location (or 
locations) in the Additional locations for rendering sets parameter in the Workshare 
Configuration Manager (Comparison > Administration category). Workshare Compare 
looks in the two default locations (specified above) to create a list of the possible rendering 
sets available and will also look in any additional locations specified in this parameter.
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Applying rendering sets

You apply a rendering set to a comparison before the comparison is run and you can also 
apply a rendering set at any time after a comparison has been performed.

To apply a rendering set after the comparison has been run:

 Refer to Applying a different rendering set

 Refer to Changing the comparison options

Accessing the Rendering Sets Manager

The Rendering Sets Manager is accessible from the Workshare Configuration Manager, 
from Workshare Compare and from the Litera tab in Microsoft Office.

From the Workshare Configuration Manager

Access the Workshare Configuration Manager and select the Rendering Set Manager tab.
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If you have permissions, you can modify and delete existing rendering sets and create new 
rendering sets. Refer to Customizing Rendering Sets.

Before running a comparison

Before running a comparison, click in the Compare Documents dialog.

If you have permissions, you can modify and delete existing rendering sets and create new 
rendering sets. Refer to Customizing Rendering Sets.

Additionally, you can edit the rendering set parameters as required and click OK. The 
Save Rendering Set dialog is displayed where you can either:

 Enter the name of an existing rendering set to overwrite a rendering set or enter a 
new name to create a new rendering set. Do not use the following characters when 
naming rendering sets: <, >, :, \, “, /, \\ or |. Click Yes. The updated rendering set is 
saved and it is selected in the Compare Documents dialog.

 Click No. The revised options are saved as a temporary rendering set called 
“Custom rendering set” and this rendering set is selected in the Compare 
Documents dialog.
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After running a comparison

In the Workshare Compare main window, click Edit in the Home ribbon (Comparison 
Themes group).

If you have permissions, you can modify and delete existing rendering sets and create new 
rendering sets. Refer to Customizing Rendering Sets.

Additionally, you can re-run a comparison changing specific comparison options. Refer to 
Changing the comparison options.
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Customizing Rendering Sets

If you have the relevant access rights, you can modify and delete existing rendering sets 
as well as create new rendering sets.

Note: Depending on how Workshare Compare has been distributed through the 
company, you may or may not have access rights to configure rendering sets. If you have 
any questions about your access rights, please speak to your system administrator.

Modifying existing rendering sets

If you have permission, you can modify the settings of an existing rendering set.

To modify an existing rendering set:

1. In the Rendering Sets Manager, select the rendering set you want to modify from 
the Rendering Set dropdown list.

2. Configure or modify the parameters for the rendering set as follows:

 Click a category in the left pane to display parameters for that category in the 
right pane.

 Configure the parameters as required.

Categories and their parameters are described in Rendering Set Parameters.

3. Click Save. The modified settings are saved to the selected rendering set.

Creating new rendering sets

If you have permission, you can create a new rendering set. You create a new rendering 
set based on an existing rendering set and then modify it as required.

To create a new rendering set:

1. In the Rendering Sets Manager, select the rendering set on which you want to base 
your new rendering set from the Rendering Set dropdown list.
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2. Click Save As. The Save Rendering Set dialog is displayed:

3. Enter a name for the rendering set. Enter the name of an existing rendering set to 
overwrite a rendering set or enter a new name to create a new rendering set. Do 
not use the following characters when naming rendering sets: <, >, :, \, “, /, \\ or |.

4. Click OK. The new rendering set is selected in the Rendering Set dropdown list.

5. Configure or modify the parameters for the rendering set as follows:

 Click a category in the left pane to display parameters for that category in the 
right pane.

 Configure the parameters as required.

Categories and their parameters are described in Rendering Set Parameters.

6. Click Save. The settings are saved to your new rendering set.

Deleting rendering sets

If you have permission, you can delete rendering sets from the Rendering Sets Manager.

To delete a rendering set:

1. In the Rendering Sets Manager, select the rendering set that you want to delete 
from the Rendering Set dropdown list.

2. Click Delete. The selected rendering set is deleted.

Rendering Set Parameters

The parameters for rendering sets are grouped into the following categories:

 Comparison Options

 Redline Options

 Redline Rendering
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The categories appear in the left pane of the Rendering Sets Manager. Selecting a 
category displays the parameters for that category in the central pane. The right hand 
pane show a preview of how the redline will look with the parameters selected.

Comparison Options

The Comparison Options category includes parameters that enable you to customize 
how the compare is performed.
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The Comparison Options parameters are described in the following table:

Parameter Description

Allow Auto Retry When selected, if a comparison fails for any reason then 
Workshare Compare automatically attempts to perform a 
comparison using reduced settings. Workshare Compare 
methodically and automatically disables the Comparison Options 
selected until it is able to perform a comparison.

Detect List 
Numbering
Changes

If selected, changes to automatically generated list numbers for 
numbered paragraphs are detected.

Detect 
Footnote/Endnote
Numbering
Changes

If selected, changes to the numbering of footnotes and endnotes 
are detected. You may want to deselect this parameter yet keep 
the Compare Footnotes parameter selected. This way, changes 
to the content of footnotes and endnotes will be detected but not 
changes to the numbering.

Compare 
Headers/Footers

If selected, the headers and footers in the original and modified 
documents are compared.

Compare Footnotes If selected, the footnotes in the original and modified documents 
are compared.

Compare at 
Character Level

If selected, words that are only slightly different from each other 
are compared. For example, if banana has been changed to 
bananas - Workshare Compare shows just an insertion of an s in 
the redline, rather than showing a deletion of banana and an 
insertion of bananas. This is intended to catch simple typing 
mistakes.

Compare Numbers 
at Character Level

As above description, but compares numbers instead of 
characters.

Ignore Embedded 
Objects/Images

If selected, embedded objects and images are ignored while 
doing the comparison and will not be displayed in the redline.

If not selected, the embedded objects and images will appear in 
the redline (although changes to them are not detected unless the 
Detect changes to Images parameter is selected.)

This option is useful when documents have very large images 
embedded in them which would produce vast amounts of data if 
written to the redline RTF file and would slow down the 
comparison process and the loading of the redline.

Ignore Case 
Changes

If selected, any case changes (for example, upper case to lower 
case) are not compared and the content of the modified 
document is shown in the redline document.

Ignore Text Boxes If selected, any text boxes are not compared and the content of 
the modified document is shown in the redline document.
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Parameter Description

Ignore Field Codes If selected, any field codes are not compared and the content of 
the modified document is shown in the redline document.

If not selected, field codes are compared and where they have 
changed, the entire original field is shown as deleted and the 
entire modified field is shown as inserted.

Compare field 
contents as text

If selected, converts certain field codes to text and then 
compares. If not selected, compares field code only. Fields 
converted to text will not be subject to the Ignore Field Codes
parameter if that is also selected.

Note: The following field codes are converted to text: TOC, 
REF, TOA, TA, DATE, TIME, COMMENTS, KEYWORDS, 
AUTHOR, FILENAME, SAVEDATE, CREATEDATE, 
PAGEREF, INDEX, DOCPROPERTY, TITLE, MERGEFIELD, 
NOTEREF, SHAPE, QUOTE. Other field codes will be dealt 
with according to the Ignore Field Codes parameter setting.

For example, where there is a date field that in the original 
document shows 1 Jan 2012 and in the modified updates to 31 
Jan 2012. When this parameter is selected, the redline will show 
131 Jan 2012. Where this parameter is not selected, no change 
will be shown.

Ignore Tables If selected, any tables are not compared and the content of the 
modified document is shown in the redline document.

Display comments
in redline

If selected, comments in the original and modified documents are 
compared.

How to detect 
changes to images

If selected, images in the original and modified documents are 
compared. You can select from the following options:

 Insertions/deletions: Detects whether images have been 
inserted or deleted.

 Pixel-by-pixel: Detects whether the actual content of an 
image has changed.

 Do not compare: Images are not compared at all.

In order for images to be compared, you must ensure that the 
Ignore Embedded Objects/Images parameter is NOT selected.

Ignore auto list 
against manual 
number list 
changes

If selected, when an automatically formatted list is being 
compared against a manual list, any changes in the manual list 
are ignored.

Generally this parameter should NOT be selected. It should only 
be selected in circumstances when one of the documents being
compared contains automatic list numbering and the other 
document contains manual list numbering.



Configuring Rendering Sets

124

Parameter Description

Use classic table 
comparison

If selected, tables are compared as they were in releases prior to 
Workshare Compare 10.1 Revision 1.

The Workshare Compare 10.1 Revision 1 release introduced an 
updated method of table comparison that creates more readable 
results in the vast majority of cases.

Redline Options
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The Redline Options category includes parameters that enable you to customize how the 
redline is displayed and what information is included with the redline.

The Redline Options parameters are described in the following table:

Parameter Description

General Options

Include redline
statistics

If selected, statistics about the changes between the original 
and modified documents are displayed in the redline. You can 
select to display these statistics at the start of the document 
or at the end of the document.

Include Redline 
Comparison Summary

If selected, a summary of all the changes is displayed at the 
end of the redline. The changes are hyperlinked to take you 
directly to the change in the redline.

Include Redline Option 
Summary

If selected, a summary of the options selected in the current 
rendering set is displayed at the end of the redline in the 
statistics report. 

Display Workshare 
Compare Footers

If selected, details about the two documents being compared 
are displayed in the footer of the redline.

Black And White 
Headers

If selected, changes detected in the header are rendered in 
black and white. The color scheme set up in the rendering set 
is maintained for changes to all other parts of the document.

Black And White 
Footers

If selected, changes detected in the footer are rendered in 
black and white. The color scheme set up in the rendering set 
is maintained for changes to all other parts of the document.

Show Moved Deletions If selected, text that was deleted from a section of the 
document and then subsequently moved to a new location is 
indicated.

Show Changes to 
Spaces

If selected, any extra spaces that have been added to or 
deleted from the modified document are indicated. 

Show Paragraph 
Changes

If selected, paragraph markers ( ) of any extra paragraphs 
that have been added to or deleted from the modified 
document are displayed.

Include file names in 
Redline statistics

If selected, the names of the compared documents are 
included in the redline statistics.

Change Indicator Options

Show Hidden Text If selected, hidden text is displayed in the redline.

Show Line Numbering If selected, the line number is displayed to the left of each line 
in the margin of the redline.

Show Change 
Numbering ToolTips

If selected, tool tips are displayed when you position the 
cursor over change numbers.
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Parameter Description

Show change bars If selected, vertical lines to indicate a change are displayed 
next to each change in the margin of the redline. You can 
select to display the lines either in the Left or Right margin.

Show change numbers If selected, the change number is displayed next to each 
change in the margin of the redline. You can select to display 
the number either in the Left or Right margin.

Readability See the Readability section below.

Note: The change indicator settings do not show if you open the redline in Microsoft 
Word.

Readability

The Readability option enables you to set at what point insertions and deletions should no 
longer be marked individually but marked as an entire paragraph deleted followed by an 
entire paragraph inserted. The deleted paragraph is as the paragraph appears in the 
original document and the inserted paragraph is as the paragraph appears in the modified 
document.

For example, the following paragraph showing numerous deletions and insertions is quite 
difficult to read:

DeltaView Redline with Table of Contents: (Vendor)When performing a Redline where the document contains 
ancontents issue: An error occurs in the number of bullet points when DeltaView does a Redline on a document where the 

table of contents is automatically generated Table of Contents, the DeltaView output does not number the sections 

properly. This happens in DeltaView or if the file format is *.wdf. Workaround: Save the RedlineWord. Workaround: Save 

the table of contents in as a new document or email the Redline as a Word document, it formats correctly. We are working 

with the vendor for a resolutionDOC file and open it in Word before printing.

It would be much easier to read this paragraph if it was presented as the entire paragraph 
deleted followed by a new paragraph inserted, as follows:

DeltaView Redline with Table of Contents: (Vendor)When performing a Redline where the document contains an 
automatically generated Table of Contents, the DeltaView output does not number the sections properly. This happens in 
DeltaView or if the file format is *.wdf. Workaround: Save the Redline as a new document or email the Redline as a Word 
document, it formats correctly. We are working with the vendor for a resolution.

DeltaView Table of contents issue: An error occurs in the number of bullet points when DeltaView does a Redline on a 
document where the table of contents is automatically generated in Word. Workaround: Save the table of contents in as a 
DOC file and open it in Word before printing.

Obviously, if there were only a few deletions and insertions in a paragraph, then the first 
example is easy to read.
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With the Readability parameter, you can specify at what point Workshare Compare no 
longer marks deletions and insertions individually but marks the entire paragraph as a 
deletion followed by the new paragraph as an insertion. You specify this by setting a 
readability percentage by dragging the Paragraph Matched Text Threshold slider to your 
required setting. The percentage selected is shown in a tool tip below the slider.

The meaning of the setting is as follows:

 With readability set at 10%, Workshare Compare will mark insertions and deletions 
individually unless 90% of the paragraph has changed. In other words, in most 
circumstances paragraphs will be displayed in the same way as the first example 
shown previously. Only when more than 90% of the paragraph has changed will 
Workshare Compare display the paragraph as the second example.

 With readability set at 50%, Workshare Compare will mark insertions and deletions 
individually unless 50% of the paragraph has changed. In other words, paragraphs 
will be displayed in the same way as the first example shown previously unless 
more than 50% of the paragraph has changed.

 With readability set at 90%, Workshare Compare will mark insertions and deletions 
individually unless 10% of the paragraph has changed. In other words, in most 
circumstances paragraphs will be displayed in the same way as the second 
example shown previously. Only when less than 10% of the paragraph has 
changed will Workshare Compare display the paragraph as the first example.

The default setting for readability is 10%.

Workshare Compare looks at each paragraph separately and assesses its readability 
according to the number of changes in the paragraph.

Note: When working with tables, Workshare Compare does not treat the entire table as a 
paragraph. Each paragraph within each cell is treated separately.

Readability only applies to paragraphs that contain both inserted and deleted text because 
such paragraphs may be unclear whereas paragraphs with only insertions or deletions do 
not have such readability problems.
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Redline Rendering

The Redline Rendering category includes parameters that enable you to customize how 
specific types of changes are displayed in the redline.

The Redline Options parameters are presented in the following sections:

Inserted Text 

The Inserted Text section includes parameters that enable you to customize how you 
would like inserted text to appear in the redline.
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The Inserted Text parameters are described in the following table:

Parameter Description

Inserted Text Color The color of inserted text.

Inserted Text 
Background

The color of the background of inserted text.

Inserted Text Format The format of inserted text. Select from Underline, Double 
Underline, Italic or Strikethrough.

Surrounding 
Characters

A keyboard character to go before and after inserted text.

Deleted Text 

The Deleted Text section includes parameters that enable you to customize how you 
would like deleted text to appear in the redline.

The Deleted Text Format parameters are described in the following table:

Parameter Description

Deleted Text Color The color of deleted text.

Deleted Text 
Background

The color of the background of deleted text.

Deleted Text 
Format

The format of deleted text. Select from Underline, Double 
Underline, Italic or Strikethrough.

Surrounding 
Characters

A keyboard character to go before and after deleted text.



Configuring Rendering Sets

130

Parameter Description

Deleted Text 
Replacement 
Character

The character used to replace deleted text. If the Replace Deleted 
Text with a Single Character checkbox is selected, the deleted 
text is replaced with a single instance of the character specified. If 
the Replace Deleted Text with a Single Character checkbox is 
not selected, each character in the deleted text is replaced with the 
character specified. For example, if the word compare is deleted 
and the character specified is X, the word appears as XXXXXXX. 

Replace Deleted 
Text with a Single 
Character

If selected, deleted text is replaced with a single character. If you 
select this checkbox, enter the required character in the Deleted 
Text Replacement Character field. For example, if the word 
compare is deleted and the character specified is X, the word 
appears as X.

Include summary 
of deletions

If selected, a summary of deletions is included with the redline.

Moved Text 

The Moved Text section includes parameters that enable you to customize how you would 
like moved text to appear in the redline.



Configuring Rendering Sets

131

The Moved Text parameters are described in the following table:

Parameter Description

Show Movements If selected, moved text is shown in the redline. If you leave this 
checkbox unchecked, then any text that has been moved is 
displayed the same as inserted and deleted text.

Note: Text is only shown as moved if it's over 22 characters. 
Anything less will be shown as insertions and deletions. This 
is to prevent showing moved text incorrectly. For example, if 
someone had deleted the word "and" from one paragraph 
and added "and" in another, they probably have not moved 
the text, rather they are just changing the individual 
paragraphs, so would want them displayed as insertions and 
deletions. 

Moved Text Color The color of moved text.

Moved Text 
Background

The color of the background of moved text.

Moved Source Text 
Format

The format of the source moved text. Select the format of the 
text in its original position from Underline, Double Underline, 
Italic or Strikethrough.

Moved Destination 
Text Format

The format of the destination moved text. Select the format of 
the text in its new position from Underline, Double Underline, 
Italic or Strikethrough.

Move Source 
Surrounding 
Characters

A keyboard character to go before and after source moved text. 
Specify the characters to surround the text in its original 
position.

Move Destination 
Surrounding 
Characters

A keyboard character to go before and after destination moved 
text. Specify the characters to surround the text in its new 
position.
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Change Numbering 

The Change Numbering section includes parameters that enable you to select whether 
change numbers are shown in the redline and, if so, how they appear.

The Change Numbering parameters are described in the following table:

Parameter Description

Show Change 
Numbering

If selected, the number of the change is displayed next to each 
change in the body of the redline (as superscript). 

Show Change
Numbering 
before Change

If selected, the change number is displayed before the change. If not 
selected, the change number is displayed after the change. It is 
recommended to position the change number before the change as 
footnotes often appear after text. This reduces confusion.

Change Number 
Text Color

The color of change numbers.

Change Number 
Text Format

The format of change numbers. Select from a range of formats, 
including Superscript or Bold.

Font Changes 

The Font Changes section includes parameters that enable you to customize how you 
would like any font changes to appear in the redline.

The Font Changes parameters are described in the following table:

Parameter Description

Show Font Changes If selected, font changes are shown in the redline.
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Parameter Description

Font Change Text 
Color

The color of font changes.

Font Change Text 
Background

The color of the background of font changes.

Surrounding 
Characters

A keyboard character to go before and after font changes.

Note: Insertions and deletions override any font changes. For example, if the modified 
document has new inserted text in a different font, it appears as inserted text and not as 
font change text.

Style Changed Text

The Style Changed Text section includes parameters that enable you to customize how 
you would like any style changes to appear in the redline.

The Style Changed Text parameters are described in the following table:

Parameter Description

Show Paragraph 
Style Changes

If selected, paragraph style changes are shown in the redline. 
Paragraph style changes are indicated in words, for example, 
normal to heading two.

Style Changed 
Label Color

The color of text in paragraphs where the paragraph style has 
changed.

Show Character 
Style Changes

If selected, character style changes are shown in the redline.

Style Changed
Color

The color of character style changes.
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Parameter Description

Style Changed
Background

The color of the background of character style changes.

Style Changed
Format

The format of character style changes. Select from Underline, 
Double Underline, Italic or Strikethrough.

Surrounding 
Characters

A keyboard character to go before and after style changed text.

Note: Changes to heading styles are also shown in the statistics report at the end of the 
redline.

Table Changes

The Table Changes section includes parameters that enable you to customize how you 
would like any format changes in tables to appear in the redline.

The Table Changes parameters are described in the following table:

Parameter Description

Table Change 
Options

The way changes in tables are indicated. You can select from 
the following: Changes with surrounding characters, 
Changes without surrounding characters, Whole original 
and modified tables, Whole modified table only or Whole 
modified table only (unmarked).

Selecting Whole modified table only (unmarked), the 
modified table is shown in the redline as a new table with no 
changes marked. Selecting Whole modified table only, the 
modified table is also shown in the redline as a new table but it 
is shown as an insertion.

Table Cell Inserted 
Color

The color of inserted cells.
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Parameter Description

Table Cell Deleted 
Color

The color of deleted cells.

Table Cell Moved 
Color

The color of moved cells.

Table Cell Merged 
Color

The color of merged cells.

Table Cell Padding 
Color

The color of padded cells.

What are padded cells?

Padded cells occur when an insert and delete have occurred within a table, a cell becomes 
both an insert and a delete; therefore it creates a padded cell.

Original Table
Cell 1 Cell 2 Cell 3
Cell 4 Cell 5 Cell 6

Modified Table
Cell 1 Cell 3
Cell A Cell B
Cell 4 Cell 6

Rendered Table
Cell 1 Cell 2 Cell 3

Cell A PADDED CELL Cell B

Cell 4 Cell 5 Cell 6
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Appendix B. Configuring Comparison 
Themes
This appendix describes how to configure comparison themes for Workshare Compare for 
PowerPoint and apply them to a comparison. It includes the following sections:

 Introducing Comparison Themes, page 137, introduces Workshare Compare 
comparison themes and describes how they determine the look of a comparison.

 Applying Comparison Themes, page 137, describes how to apply a comparison 
theme to a comparison.

 Customizing Comparison Themes, page 138, describes how to create your own 
comparison themes as well as modify existing comparison themes.

 Comparison Theme Parameters, page 140, provides a detailed description of all 
the comparison theme parameters.
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Introducing Comparison Themes

Workshare Compare for PowerPoint uses colors and different formats in the comparison to 
enable you to see the changes that have been made to the presentation.

The colors and formats adopted depend on the comparison theme applied to the 
comparison. Workshare Compare for PowerPoint includes a default comparison theme
that you can apply or you can modify this comparison theme or create your own 
comparison theme.

Applying Comparison Themes

You can apply a comparison theme to a comparison before the comparison is run and also
at any time after a comparison has been performed.

To apply a comparison theme before the comparison is run:

In the Select Presentations for Comparison dialog, select a comparison theme from the 
Select Comparison Theme dropdown list.

To apply a comparison theme after the comparison has been run:

In the Comparison Themes group of the Home tab, select a comparison theme from the 
Select dropdown list. Workshare Compare for PowerPoint re-performs the comparison 
applying the new comparison theme styles to the resulting comparison.
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Customizing Comparison Themes

You can modify existing comparison themes as well as create new comparison themes.
Comparison themes are created and modified in the Comparison Themes Manager.

To open the Comparison Themes Manager:

Select Edit in the Comparison Themes group of the Home tab. The Comparison Themes 
Manager is displayed.

Note: You can also click to the right of the Select Comparison Theme field in the 
Select Presentations for Comparison dialog.

Comparison themes are made up of a set of parameters. The comparison theme 
parameters are grouped into categories. The categories appear in the left pane of the 
Comparison Themes Manager. Selecting a category displays the parameters for that 
category in the right pane of the Comparison Themes Manager. The different categories 
and their parameters are described in Comparison Theme Parameters.
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Creating new comparison themes

You can create new comparison themes as required to determine the colors and formats
used in the comparison to distinguish the changes that have been made to the 
presentation.

To create a new comparison theme:

1. In the Comparison Themes Manager, click Create New. The Comparison Theme 
Name dialog is displayed.

2. Enter a name for the comparison theme and click OK.

3. In the Comparison Themes Manager, specify the comparison theme parameters as 
follows:

 Click a category in the left pane to display parameters for that category in the 
right pane.

 Configure the parameters as required.

Categories and their parameters are described in Comparison Theme Parameters.

4. Click Apply. The new comparison theme is saved.

Note: When you click OK in the Comparison Themes Manager, Workshare Compare for 
PowerPoint re-performs the comparison applying the new comparison theme styles to the 
resulting comparison.

Modifying existing comparison themes

You can modify existing comparison themes by changing the parameter settings for the 
comparison theme or changing the name of the comparison theme. You can also delete 
unwanted comparison themes.

To modify an existing comparison theme:

1. In the Comparison Themes Manager, select the comparison theme you want to 
modify from the dropdown list.
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2. Modify the comparison theme parameters as follows:

 Click a category in the left pane to display parameters for that category in the 
right pane.

 Configure the parameters as required.

Categories and their parameters are described in Comparison Theme Parameters.

3. Click Apply.

Note: When you click OK in the Comparison Themes Manager, Workshare Compare for 
PowerPoint re-performs the comparison applying the new comparison theme styles to the 
resulting comparison.

To rename a comparison theme:

1. In the Comparison Themes Manager, select the comparison theme from the 
dropdown list and click Rename. The Comparison Theme Name dialog is 
displayed.

2. Enter the new name for the comparison theme and click OK. The comparison 
theme is saved with the new name.

To delete a comparison theme:

In the Comparison Themes Manager, select the comparison theme that you want to delete 
from the dropdown list and click Delete. The comparison theme is deleted.

Note: You can delete one of the predefined comparison themes but all predefined 
comparison themes are regenerated when Workshare Compare for PowerPoint is 
launched.

Comparison Theme Parameters

The comparison theme parameters for Workshare Compare for PowerPoint are grouped 
into the following categories:

 Comparison

 Insertions

 Deletions

 Moves

 Property Changes

 Font Changes

 Sensitivity
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Comparison

The Comparison category includes parameters that enable you to specify what changes 
Workshare Compare for PowerPoint will detect.

The Comparison parameters are described in the following table:

Parameter Description

Detect Changes to Select the specific items that Workshare Compare for 
PowerPoint will detect changes to, from the following: Speaker 
Notes, Image Content, Embedded Object Content, Item
Location and Size, Text Formatting, Text Box Formatting, 
Slide Background, Hyperlink Target, Autoshape Style and 
Orientation.

Detect Moved Text If selected, moved text within slides is detected.

Detect Moved Slides If selected, moved slides are detected.



Configuring Comparison Themes

142

Insertions

The Insertions category includes parameters that enable you to specify how inserted text 
as well as inserted images and objects will be displayed.

The Insertions parameters are described in the following table:

Parameter Description

Insertion options Select how insertions are displayed.

You can select any or a combination of the following 
formatting options for inserted text: Bold, Italic, Underline
and Strikethrough. (You cannot select Underline and 
Strikethrough.) You also select the font color from the Color
dropdown list.

Inserted images and objects are indicated with a dashed 
border in the selected color.

An example of how inserted text, inserted images and inserted 
charts will look with your selections is shown.
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Deletions

The Deletions category includes parameters that enable you to specify how deleted text 
as well as deleted images and objects will be displayed.

The Deletions parameters are described in the following table:

Parameter Description

Deletion options Select how deletions are displayed.

You can select any or a combination of the following 
formatting options for deleted text: Bold, Italic, Underline and 
Strikethrough. (You cannot select Underline and 
Strikethrough.) You also select the font color from the Color
dropdown list.

Deleted images and objects are indicated with a dashed 
border in the selected color.

An example of how deleted text, deleted images and deleted 
charts will look with your selections is shown.
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Moves

The Moves category includes parameters that enable you to specify how moved text as 
well as moved images and objects will be displayed.

The Moves parameters are described in the following table:

Parameter Description

Move source options Select how the source of moves is displayed.

You can select any or a combination of the following 
formatting options for source moved text: Bold, Italic, 
Underline and Strikethrough. (You cannot select Underline
and Strikethrough.) You also select the font color from the 
Color dropdown list.

The source of moved images and objects is indicated with a 
dashed border in the selected color.

An example of how source moved text, source moved images 
and source moved charts will look with your selections is 
shown.
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Parameter Description

Move destination 
options

Select how the destination of moves is displayed.

You can select any or a combination of the following 
formatting options for destination moved text: Bold, Italic, 
Underline and Strikethrough. (You cannot select Underline
and Strikethrough.) You also select the font color from the 
Color dropdown list.

The destination of moved images and objects is indicated with 
a dashed border in the selected color.

An example of how destination moved text, destination moved 
images and destination moved charts will look with your 
selections is shown.

Property Changes

The Property Changes category includes parameters that enable you to specify how 
items that have had their properties changed will be displayed.

The Property Changes parameters are described in the following table:

Parameter Description

Changed item option Select a color from the Color dropdown list. Images and 
objects that have had their properties changed are indicated 
with a dashed border in the selected color.

An example of how changed images and charts will look with 
your selection is shown.
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Font Changes

The Font Changes category includes parameters that enable you to specify how text that 
has had its font changed will be displayed.

The Font Changes parameters are described in the following table:

Parameter Description

Changed font option Select a color from the Color dropdown list. Text that has had 
its font changed is displayed in the selected color.

An example of how changed text will look with your selection 
is shown.
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Sensitivity

The Sensitivity category includes parameters that enable you to specify how sensitive 
Workshare Compare for PowerPoint should be when detecting changes.

The Sensitivity parameters are described in the following table:

Parameter Description

Slide similarity 
threshold (%)

Specify at what point insertions and deletions should no 
longer be marked individually but marked as an entire slide 
deleted and an entire slide inserted.

For example, if you set the threshold at 30% and the 
similarity between the slides is calculated to be less than 
30% then they will be shown as an inserted and deleted 
slide. If the similarity is calculated as more than 30% then 
the slides will be shown with changes found to individual
items on the slides.

Drag the slider to your required setting. As you drag the 
slider, the percentage is shown as a tool tip above the slider.
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Parameter Description

Text Box similarity 
threshold (%)

Specify at what point insertions and deletions in text boxes 
should no longer be marked individually but marked as an 
entire text box deleted and an entire text box inserted.

Drag the slider to your required setting. As you drag the 
slider, the percentage is shown as a tool tip above the slider.

Table similarity 
threshold (%)

Specify at what point insertions and deletions in tables 
should no longer be marked individually but marked as an 
entire table deleted and an entire table inserted.

Drag the slider to your required setting. As you drag the 
slider, the percentage is shown as a tool tip above the slider.

Minimum length for 
moved text

Specify the minimum number of characters to detect as a 
move – moved pieces of text shorter than this threshold will 
be shown as an insertion and a deletion.

Drag the slider to your required setting. As you drag the 
slider, the length (in characters) is shown as a tool tip above 
the slider.

Threshold for detecting 
changes in size or 
position

Specify a threshold which determines how far an object 
must be moved (or by how much its size must be changed) 
for the change to be detected. The threshold value is 
measured in inches.

Drag the slider to your required setting. As you drag the 
slider, the position (in inches) is shown as a tool tip above 
the slider.

Minimum ratio of 
unchanged text to 
surrounding changes

Specify at what point short matches of text should be 
ignored if they are surrounded on both sides by unmatched 
text. This prevents common words such as 'of', 'and' and 
'the' being matched up in a paragraph where the content has 
been completely changed.

Drag the slider to your required setting. As you drag the 
slider, the percentage is shown as a tool tip above the slider.

Note: Selecting extreme values for the Sensitivity parameters can lead to unusual 
comparison results. You can return the Sensitivity parameters to their default settings at 
any time by clicking Reset All.
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